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IMPROVED PERFORMANCE RESEARCH INTEGRATION 
TOOL (IMPRINT) ANALYSIS GUIDE 

 
The purpose of the Improved Performance Research Integration Tool (IMPRINT) 
Analysis Guide is to provide a description of the major types of analyses that can be 
performed in IMPRINT.  The format for describing each type of analysis is: 

• The goals and expected results of the analysis 
• The mental model you should have when performing this type of analysis 
• Special Guidance on the limitations or policies that might impact the analysis 
• Data requirements for the analysis  
• Major steps in performing the analysis 

 
Each chapter in this document describes a separate analysis process.  This document is 
intended to be used with the IMPRINT User’s Guide.  For additional documentation 
regarding the details of how to apply specific IMPRINT capabilities, we recommend that 
you refer to the appropriate chapter in the IMPRINT User’s Guide. 
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Chapter 1 - Crew Performance 

Goals and Results 
IMPRINT assists you in estimating the likely performance of a new weapon system by 
helping you build models of each operational mission the system will be required to 
accomplish.  Since it is typically easier to describe the mission by breaking it into smaller 
“sub” functions than describing the mission as a whole, you build these models by 
breaking down the mission into a network of functions.  Each of the functions is then 
further broken down into a network consisting of other functions and tasks.  Next, you 
estimate the time it will take to perform each task, the likelihood that it will be performed 
accurately, and the workload associated with each task.   
 
Finally, by executing a simulation model of the mission, you can study the range of 
results that will occur in the mission, functions and tasks.  Additionally, at the completion 
of the simulation, IMPRINT can compare the minimum acceptable mission performance 
time and accuracy to the predicted performance.  This will determine whether the mission 
met its performance requirements. 

Mental Model 
In IMPRINT, the operations modeling capability can be used to examine any process that 
you can describe as a flow of tasks.  Even though the examples in IMPRINT are all 
operational missions, you could use this capability to model a maintenance or logistics 
process. 
 
You can also think of the process of developing a model, running it, and analyzing results 
in much the same way you would think of designing, executing, and analyzing an 
experiment.  In this vein, you should first determine what questions you want to answer 
with this analysis.  The operations modeling capability can answer questions such as: 

• How many people do I need to perform this process within my time 
constraints? 

• How long will it take to perform this process? 
• How “risky” is the process (i.e., what is the probability of success)? 

After you have defined the questions you are trying to answer, you should select your 
dependent and independent variables.  Then, you should design your analysis process.  
After these items have been determined, you will be better equipped to design a model 
that will be responsive to your analytical needs. 
 
It is also much easier to debug a model if you add parameters to it in an incremental 
fashion.  In other words, you should lay out the network diagram first, then add task 
times.  Next, execute the model to be sure the branching logic is running the way you 
expect.  If everything seems to be working in the way you intended, then you can go back 
to the tasks and add accuracy information.  Run the model again to check that your 
accuracy data have had an effect that makes sense to you.  Then, consider whether you 
would add taxon and stressor information.  By moving through your analysis in an 
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incremental way, you can simplify the process of verifying that IMPRINT is interpreting 
your model in the way you expected.   
 
It is often difficult to find sources of data for this type of model.  While IMPRINT can 
provide you some help in this area (e.g., libraries of existing models, inclusion of human 
performance micromodels), you will need to try identifying sources of data.  You may be 
able to get some data from the Operational Requirements Document (ORD) of your 
system, test and evaluation reports of a predecessor, but similar system, or from subject 
matter experts on your system.  If data elements exist for which you do not have any 
existing data, we recommend that you identify the most likely and worst case values for 
these elements.  You can then run the IMPRINT model iteratively to determine how 
sensitive the model results are to the variability of these data items.  If the model is not 
very sensitive to the values in question, then you probably do not need to invest a lot of 
resources in finding better data.  If the model is very sensitive, then you can either work 
to improve the quality of your data, or you can provide a decision maker with 
information on the most likely and worst case results. 

Special Guidance 
If you want to refer to a specific Military Occupational Specialty (MOS) in your analysis, 
you must first go to the Define Soldiers menu option and add the MOS to your analysis.  
You can do this by either copying from an existing library system, or by accessing the 
directory of MOS’s provided in the Define Soldiers capability.  This process is described 
in Chapter 6, “Soldier Characteristics,” in this Analysis Guide. 

Data Requirements 
The data in an IMPRINT operational mission analysis are hierarchically organized.  
Below, we describe the data elements, and indicate which are required, and which are 
optional.  You should be aware that in IMPRINT, we attempt to provide defaults for 
every data element that is required.  For this reason, even though a data element is 
“required” you may not actually have to enter it yourself.  In fact, an IMPRINT 
operational mission will run as soon as you have drawn a task network.  This is because 
the required data items (e.g., task time, task accuracy estimate) default to values that 
enable the model to run. 
 
Note that each data element is defined in the glossary provided in the IMPRINT User’s 
Guide. 
 

IMPRINT 
Level 

Data Element Required? Default Value 

Analysis Name Yes  
Analysis  Version Yes  
Analysis Description No  
Mission Name Yes  
Mission Time Standard No 00:00:00.00 
Mission Time Criterion No 0.00 
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Mission Accuracy Criterion No 0.00 
Mission Mission Criterion No 0.00 
Mission Description No  
Function Name Yes Unnamed # 
Function Time Standard No 00:00:00.00 
Function  Criterion No 0.00 
Function Branching Logic Yes  
Task Name Yes Unnamed # 
Task Time Standard No 00:00:00.00 
Task  Accuracy Standard No 0.00 Percent Steps 

Correct 
Task Estimated Time Yes 00:00:00.00 
Task Time Standard Deviation No 00:00:00.00 
Task Time Distribution No Normal 
Task Estimated Accuracy Yes 0.00 
Task Failure Consequences Yes No Effect 
Task Branching Logic Yes  

Analysis Steps 
In this document, we describe the steps required to perform the analysis.  You can find a 
detailed description of how to perform each step in Chapter 3, “Using IMPRINT,” of the 
IMPRINT User’s Guide.  Additionally, please be aware that the sequence of steps 
provided in this document is often just one method of performing the analysis.  As with 
most Windows products, the same operations can often be performed just as effectively 
in a different order. 
 
1. Begin a new analysis - Open IMPRINT.  From the File menu, choose New.  You will 

see a dialog box in which you must enter an Analysis Name and Version.  Once 
entered, choose OK.  

 
2. Define Mission - From the Define menu, choose System Mission.  You will see a 

dialog box that lists the missions that currently exist for your analysis. 
 
3. Add a new mission - Use the Add button.  Enter a mission name. 
 
4. Enter performance standards - Highlight the mission you just added, and press the 

Open button.  You will see the Mission Information dialog.  If you want IMPRINT to 
compare the predicted performance to the required mission performance, then you 
must enter the mission level performance standards on this dialog.  If you do not want 
this comparison, then you can leave all the text boxes with the default information. 

 
5. Go to the task network diagram - Press the Functions + Tasks button to get to the list 

of functions and tasks at the top level of your mission.  You can enter the functions 
and tasks using these lists, or you can proceed to the network diagram and use the 
drawing space to illustrate your network. 
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6. Draw a network to show task sequence - Press the Network Diagram button.  The 

network diagram will be blank except for the start and end functions that are required 
in each mission.  Use the tool bar and select the Function or Task tool.  Click on the 
network workspace to place the new node.  Use the tool bar and select the Path tool.  
Draw paths between your nodes to show the sequence of the tasks and functions.  For 
more detailed information on what each tool on the tool bar is used for, and how to 
navigate around the network, access IMPRINT on-line help, or see Chapter 3 in the 
IMPRINT User’s Guide. 

 
7. Enter task data - Double click on each task node to view the task information dialog.  

You will notice that this dialog has tabs along the bottom edge that enable you to 
view data that are attached to each task in your mission.  For this example, we only 
are interested in information on the Timing and Accuracy tab.  This is the first tab. 

 
8. Enter time and accuracy predictions - If you want IMPRINT to compare predicted 

performance to required performance at the task level, you must enter the Time and 
Accuracy Standards and Criteria.  In particular, we recommend that you enter the 
accuracy standard and measure in order to document what you mean by “accurate 
performance” on this task.  This will be helpful to other people who review your 
mission and it can also be helpful to you when you attempt to estimate the probability 
of task success.  It is important that you enter the Estimated Task Time and 
Estimated Task Accuracy data elements.  These data elements are used to drive the 
mission simulation model.  You can use the Previous and Next buttons to move 
through the tasks within each function of your mission.  Enter these data for every 
task in your mission.  You can exit out of the network diagram by using the Close 
box on the network drawing window.  Use the OK buttons to return to the top level 
of the mission.  IMPRINT will prompt you to save the network diagram. 

 
9. Save your mission - Use the Save command on the File menu to save your data.  We 

strongly recommend that you use this command often during your IMPRINT session. 
 
10. Execute the Operations Mission - Access the Execute menu, and select the 

Operations Model option.  Notice that you can vary the number of times you want to 
run the mission model and the random number seed.  Press the Run Model button.  
When the model is finished (it should run very quickly), you will be reminded that 
you can access the results using the Reports menu. 

 
11. View Mission Performance, Function Performance and Task Performance Reports - 

Access the Reports menu in IMPRINT and select the Operations Model menu item.  
Highlight the Mission Performance Report, Function Performance Report and 
the Task Performance Report, and press the Reports button.  The Mission 
Performance Report will tell you the predicted total mission performance time, and 
whether the mission was performed accurately.  If you entered mission level 
standards, the predicted results will be compared to the standards.  Similarly, the 
Function Performance Report will provide an estimate of the total simulated time it 
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took to perform each function.  If available, this value will be compared to your 
function time standard.  Finally, the simulated results for every task will be provided 
in the Task Performance Report.  This will include the number of times each task 
occurred in the model, as well as the predicted time for each task and the percentage 
of times each task was performed accurately.  These values will be compared to the 
task standards. 
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Chapter 2 - Crew Workload (VACP) 

Goals and Results 
IMPRINT assists you in estimating the workload associated with the performance of a 
new weapon system by helping you build task network workload models of each 
operational mission the system will be required to accomplish.  Since it is typically easier 
to describe the mission by breaking it into smaller pieces than describing the mission as a 
whole, you build these models by breaking down the mission into a network of functions.  
Each of the functions is then further broken down into a network consisting of other 
functions and tasks.  Next, you estimate the time it will take to perform each task, the 
likelihood that it will be performed accurately, and the workload associated with each 
task.   
 
You can evaluate the workload using the Visual, Auditory, Cognitive, and Psychomotor 
(VACP) method or the Advanced Workload method.  The VACP method is simpler and 
is intended to be used early in your design process.  The Advanced Workload method 
provides a much more detailed look at the workload issue and enables you to examine the 
impact of workload management strategies.  We recommend that you begin by using the 
VACP method, and if necessary, apply the Advanced Workload method as your analysis 
matures.  When you change a mission from one method to the other, using the radio 
button at the bottom of the Define Mission dialog, all your data will be preserved and the 
relevant data applied to the other analysis. 
 
In the VACP method of workload computation, workload scores are summed within 
channels (e.g., Visual, Auditory) across concurrent tasks.  For example, if the same 
operator is performing two tasks at once, and the first task has a Visual workload score of 
4.1 and the second task has a Visual workload score of 3.2, then for the amount of time 
the two tasks overlap that operator’s total Visual workload score would be 7.3. 
 
When you execute the simulation model of the mission, you will get results that show the 
workload values over time for each operator of your system.  By examining this 
workload graph, you can determine where the workload peaks are, and which tasks were 
operating at that time and contributed to the peaks.  These tasks are candidates for 
redesign, automation, or reallocation to another crewmember.  Additionally, all 
capabilities described in the previous chapter, “Crew Performance,” are available when 
you are developing a workload model.  Therefore, in addition to providing output 
regarding the workload, IMPRINT can compare the minimum acceptable mission 
performance time and accuracy to the predicted performance.  This will determine 
whether the mission has met its performance requirements. 

Mental Model 
In IMPRINT, the workload modeling capability can be used to examine any process, that 
you can describe as a flow of tasks.  Even though the examples in IMPRINT are all 
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operational missions, you could actually use this capability to model a maintenance or 
logistics process. 
 
You can also think of the process of developing a model, running it, and analyzing results 
in much the same way you would think of designing, executing, and analyzing an 
experiment.  In this vein, you should first determine what questions you want to answer 
with this analysis.  The workload modeling capability can answer questions such as: 

• How many people do I need to perform this process within my time 
constraints? 

• How much visual, auditory, cognitive and psychomotor effort is involved in 
performing this process? 

• Is the current task allocation strategy balanced? 
After you have defined the questions you are trying to answer, you should select your 
dependent and independent variables.  Then, you should design your analysis process.  
After these items are determined, you will be better equipped to design a model that will 
be responsive to your analytical needs. 
 
It is also much easier to debug a model if you add parameters to it in an incremental 
fashion.  In other words, you should lay out the network diagram first, then add task 
times.  Next, execute the model to be sure the branching logic is the way you expect.  If 
everything seems to be working in the way you intended, then you can go back to the 
tasks and add VACP workload information.  Run the model again to check that your 
workload outputs are explainable.  If you have defined a high workload definition, 
IMPRINT will help you reallocate tasks between your crewmembers by assisting in 
removing all points of overload. 
 
If your system design is mature (i.e., the tasks and their sequence are well understood) 
and you are interested in a high fidelity workload analysis, you might change your model 
to an Advanced Workload model and implement some workload management strategies.  
These are discussed in Chapter 3, “Crew Workload (Advanced)” in this Analysis Guide. 
 
It is often difficult to find sources of data for this type of model.  While IMPRINT can 
provide you some help in this area (e.g., libraries of existing models, inclusion of human 
performance micromodels), you will need to try identifying sources of data.  You may be 
able to get some time or accuracy data from the Operational Requirements Document 
(ORD) of your system, test and evaluation reports of a predecessor, but similar system, or 
from subject matter experts on your system.  Workload data are particularly difficult to 
get.  The benchmarked scales in IMPRINT are quite descriptive and have been proven to 
be very reliable when used by people who are familiar with the system and the tasks.  If 
data elements exist for which you do not have any existing data, we recommend that you 
identify the most likely and worst case values for these elements.  You can then run the 
IMPRINT model iteratively to determine how sensitive the model results are to the 
variability of these data items.  If the model is not very sensitive to the values in question, 
then you probably do not need to invest a lot of resources in finding better data.  If the 
model is very sensitive, then you can either work to improve the quality of your data, or 
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you can provide a decision maker with information on the most likely and worst case 
results. 

Special Guidance 
The VACP workload data do not dynamically affect simulated mission performance.  In 
other words, if you have high workload during a portion of your mission, there will not 
be an associated impact on task time or accuracy.  Rather, the VACP workload method is 
meant to be a very simple and quick analysis that will enable you to identify points of 
high workload and then manually adjust your mission to reallocate tasks.   
 
IMPRINT does have the capability to perform a much more detailed and dynamic 
workload analysis, in which the task network is changed to accommodate workload 
levels as the model runs.  While this can be a much more realistic and high fidelity 
analysis, it does require that your tasks be defined very explicitly, with much more 
detailed data than is used by the VACP method.  This capability is referred to as 
“Advanced Workload” in IMPRINT.  If you are interested in this detailed analysis, 
please refer to Chapter 3, “Crew Workload (Advanced)” in this Analysis Guide for more 
information. 
 
If you want to refer to specific MOS’s in your analysis, you must first go to the Define 
Soldiers menu option and add MOS’s to your analysis.  You can do this by either 
copying from an existing library system, or by accessing the directory of MOS’s that is 
provided in the Define Soldiers capability.  This process is described in Chapter 6, 
“Soldier Characteristics” in this Analysis Guide. 

Data Requirements 
The data in an IMPRINT VACP workload analysis are hierarchically organized.  Below, 
we describe the data elements, indicating which are required, and which are optional.  
You should be aware that in IMPRINT, we attempt to provide defaults for every data 
element that is required.  For this reason, even though a data element is “required” you 
may not actually have to enter it yourself.  In fact, an IMPRINT workload analysis will 
run as soon as you have drawn a task network.  This is because the required data items 
(e.g., task time, task workload ratings) default to values that enable the model to run. 
 
Note that each data element is defined in the glossary provided in the IMPRINT User’s 
Guide. 
 

IMPRINT 
Level 

Data Element Required? Default Value 

Analysis Name Yes  
Analysis  Version Yes  
Analysis Description No  
Mission Name Yes  
Mission Time Standard No 00:00:00.00 
Mission Time Criterion No 0.00 
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Mission Accuracy Criterion No 0.00 
Mission Description No  
Mission Criterion No 0.00 
Mission Overall Workload Definition No  
Mission High Workload Definition No  
Function Name Yes Unnamed # 
Function Time Standard No 00:00:00.00 
Function  Criterion No 0.00 
Function Branching Logic Yes  
Task Name Yes Unnamed # 
Task Time Standard No 00:00:00.00 
Task  Accuracy Standard No 0.00 Percent Steps 

Correct 
Task Estimated Time Yes 00:00:00.00 
Task Time Standard Deviation No 00:00:00.00 
Task  Time Distribution No Normal 
Task Estimated Accuracy No 0.00 
Task Failure Consequences Yes No Effect 
Task Operator Assignments Yes CrewMember1 
Task Workload Ratings Yes  
Task Branching Logic Yes  

Analysis Steps 
In this document, we describe the steps required to perform the analysis.  You can find a 
detailed description of how to perform each step in Chapter 3, “Using IMPRINT,” of the 
IMPRINT User’s Guide.  Additionally, please be aware that the sequence of steps 
provided in this document is often just one method of performing the analysis.  As with 
most Windows products, the same operations can often be performed just as effectively 
in a different order. 
 
1. Begin a new analysis - Open IMPRINT.  From the File menu, choose New.  You will 

see a dialog box in which you must enter an Analysis Name and Version.  Once 
entered, choose OK. 

 
2. Define Mission - From the Define menu, choose System Mission.  You will see a 

dialog box that lists the missions that currently exist for your analysis. 
 
3. Add a new mission - Use the Add button.  Enter a mission name. 
 
4. Enter performance standards - Highlight the mission you just added, and press the 

Open button.  You will see the Mission Information dialog.  If you want IMPRINT to 
compare the predicted performance to the required mission performance, then you 
must enter the mission level performance standards on this dialog.  If you do not want 
this comparison, then you can leave all the text boxes with the default information.  
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Also, you should leave the radio button at the bottom of the dialog set to VACP 
Workload Analysis. 

 
5. Enter the list of crewmembers for your system - Click on the Crew button on the 

Mission Information dialog.  Enter the names of the crewmembers that will perform 
the tasks in your mission.  Click OK to return to the Mission Information dialog. 

 
6. Go to the task network diagram - Press the Functions + Tasks button to get to the list 

of functions and tasks at the top level of your mission.  You can enter the functions 
and tasks using these lists, or you can proceed to the network diagram and use the 
drawing space to illustrate your network. 

 
7. Draw a network to show task sequence - Press the Network Diagram button.  The 

network diagram will be blank except for the start and end functions that are required 
in each mission.  Use the tool bar and select the Function or Task tool.  Click on the 
network workspace to place the new node.  Use the tool bar and select the Path tool.  
Draw paths between your nodes to show the sequence of the tasks and functions.  For 
more detailed information on what each tool on the tool bar is used for, and how to 
navigate around the network, access IMPRINT on-line help, or see Chapter 3, “Using 
IMPRINT, in the IMPRINT User’s Guide. 

 
8. Enter task data - Double click on each task node to view the task information dialog.  

You will notice that this dialog has tabs along the bottom edge that enable you to 
view data that are attached to each task in your mission.  For this example, we are 
interested in information on the Timing and Accuracy tab, the Workload tab, and 
the Crew Assgn tab. 

 
9. Enter time and accuracy predictions - If you want IMPRINT to compare predicted 

performance to required performance at the task level, you must enter the Time and 
Accuracy Standards and Criteria. In particular, we recommend that you enter the 
accuracy standard and measure in order to document what you mean by “accurate 
performance” on this task.  This will be helpful to other people who review your 
mission and it can also be helpful to you when you attempt to estimate the probability 
of task success.  It is important that you enter the Estimated Task Time and 
Estimated Task Accuracy data elements.  These data elements are used to drive the 
mission simulation model.  You can use the Previous and Next buttons to move 
through the tasks within each function of your mission.  Enter these data for every 
task in your mission.  

 
10. Enter workload predictions - Click on the Workload tab for each task.  Using the 

combo boxes next to each workload channel (i.e., Visual, Auditory, Cognitive and 
Psychomotor), choose the rating on each scale that best describes the task.  You can 
use the Previous and Next buttons to move through the tasks within each function of 
your mission.  Enter these data for every task in your mission.   
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11. Assign operators to your tasks - Click on the Crew Assgn tab for each task.  Assign 
primary operators for each of your tasks.  For any tasks in which other crew members 
have access to the controls and displays that are needed to perform the tasks and for 
which they have the training and decision authority to perform the task, use the Add 
button to identify those crew members as secondary operators.  You can use the 
Previous and Next buttons to move through the tasks within each function of your 
mission.  Enter these data for every task in your mission.  You can exit out of the 
network diagram by using the Close box on the network drawing window.  Use the 
OK buttons to return to the top level of the mission.  IMPRINT will prompt you to 
save the network diagram. 

 
12. Save your mission - Use the Save command on the File menu to save your data.  We 

strongly recommend that you use this command often during your IMPRINT session. 
 
13. Enter an Overall Workload definition - Use the Overall Workload command under 

the Options menu to enter an expression that will combine the values of the VACP 
workload channels into a single workload score.  This step is optional, and if 
completed, will provide an additional workload score.  It will not replace the standard 
VACP scores.  Many users enter an overall expression that sums the four channels 
“V+A+C+P.” 

 
14. Enter a High Workload definition - Use the High Workload Definitions command 

under the Options menu to enter expressions that will be used to mark any areas in 
your mission as “high workload.”  You can enter up to four definitions.  Note that 
these definitions will not affect mission performance.  Rather, they will only be used 
to report specific areas of high workload to you. 

 
15. Execute the Operations Mission - Access the Execute menu, and select the 

Operations Model option.  Notice that you can vary the number of times you want to 
run the mission model and the random number seed.  Press the Run Model button.  
When the model is finished (it should run very quickly), you will be reminded that 
you can access the results using the Reports menu. 

 
16. View Operator Workload, Operator Overload and Task Overload Reports - Access 

the Reports menu in IMPRINT and select the Operations Model menu item.  
Highlight the Operator Workload, Operator Overload, and Task Overload Reports, 
and press the Reports button.  The Operator Workload Report will provide a tabular 
list of the workload of each operator every time any task began or ended in the 
mission.  It will report the Visual, Auditory, Cognitive, and Psychomotor scores.  
Additionally, it will tell you the number of ongoing tasks, and the score of the Overall 
channel, if you defined one.  The Operator Overload Report will tell you the 
percentage of time that each operator spent in an overload condition.  Finally, the 
Task Overload Report will tell you the number of times that each task began in an 
overload condition (or caused an overload condition when it began). 
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17. If any overload conditions existed in your mission model, you can use the Workload 
Overload Reassignment option on the Adjust menu to reassign some of your tasks 
to a Secondary operator.  (Note that if you did not assign any Secondary operators, 
IMPRINT will give you a message that reminds you that you do not have any other 
operators who can accept the overload tasks).  IMPRINT will automatically reassign 
tasks by moving through the overloaded tasks and attempting to find another operator 
that has access to any of the tasks that were being performed during overload.  It will 
then reassign that task, and move to the next point of overload.  Alternatively, you 
can manually reassign the tasks.  In that case, IMPRINT will provide you with a list 
of all tasks that were being performed during overload and a list of all potential 
secondary operators and their current workload at that time.  You can then select the 
secondary operator to whom you want the task reassigned.  In this way, you can move 
through the points of overload, reassigning tasks as you go.   

 
18. Review the task reassignments - In order to view the task reassignments that were 

made, access the Reports menu in IMPRINT and select the Operations Model menu 
item.  Highlight the Task Reallocation Report, and press the Reports button.  
IMPRINT will display a report that lists each reassigned task, as well as lists the old 
and new operator assignments. 

 
19. Re-run the analysis - In order to ensure that the task reassignments have alleviated 

any points of overload, you must execute the workload model again.  To do this, go to 
the Execute menu, and select the Operations Model option.  Then, repeat steps 15-
18 as necessary. 
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Chapter 3 - Crew Workload (Advanced) 

Goals and Results 
IMPRINT assists you in estimating the workload associated with the performance of a 
new weapon system by helping you build task network workload models of each 
operational mission that the system will be required to accomplish.  Since it is typically 
easier to describe the mission by breaking it into smaller “sub” functions than describing 
the mission as a whole, you build these models by breaking down the mission into a 
network of functions.  Each of the functions is then further broken down into a network 
consisting of other functions and tasks.  Next, you estimate the time it will take to 
perform each task, the likelihood that it will be performed accurately, and the workload 
associated with each task.   
 
You can evaluate workload using either the VACP method or the Advanced Workload 
method.  The VACP method is the simpler method and is intended to be used early in 
your design process.  The Advanced Workload method provides a much more detailed 
look at the workload issue and enables you to examine the impact of workload 
management strategies.  We recommend that you begin by using the VACP method, and 
if necessary, apply the Advanced Workload method as your analysis matures.  When you 
change a mission from one method to the other, using the radio button at the bottom of 
the Define Mission dialog, all your data will be preserved and applied to the other 
analysis. 
 
In the Advanced Workload method, IMPRINT has the capability to perform a very 
detailed and dynamic workload analysis, in which the task network is changed to 
accommodate workload levels as the model runs.  While this can be a very realistic and 
powerful analysis, it requires that your tasks be defined explicitly and with a much 
greater data requirement.  If you are interested in this detailed analysis, and want more 
information regarding the theoretical basis of the model, please refer to the 
documentation for this implementation of Multiple Resource Theory1. 
 
When you execute the simulation model of the mission, you will get results that show the 
total workload value over time for each operator of your system.  By examining this 
workload graph, you can determine where the workload peaks are and which tasks were 
operating at that time and contributed to the peaks.  These tasks are candidates for 
redesign, automation, or reallocation to another crew member.  Additionally, all 
capabilities described in Chapter 1, “Crew Performance” of this Analysis Guide are 
available when you are developing a workload model.  Therefore, in addition to 
providing output regarding the workload, IMPRINT can compare the minimum 

                                                 
1 Little, R., Dahl (Archer), S.G., Plott, B., Wickens, C., Powers, J., Tillman, B., Davilla, D., 
Hutchins, C. “Crew Reduction in Armored Vehicles Ergonomic Study (CRAVES),” Report No. 
ARL-CR-80, prepared for the Army Research Laboratory, July 1993. 
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acceptable mission performance time and accuracy to the predicted performance.  This 
will determine whether the mission has met its performance requirements. 

Mental Model 
In IMPRINT, the workload modeling capability can be used to examine any process that 
you can describe as a flow of tasks.  Even though the examples in IMPRINT are all 
operational missions, you could actually use this capability to model a maintenance or 
logistics process. 
 
You can also think of the process of developing a model, running it, and analyzing results 
in much the same way you would think of designing, executing, and analyzing an 
experiment.  In this vein, you should first determine what questions you want to answer 
with this analysis.  The workload modeling capability can answer questions such as: 

• How many people do I need to perform this process within my time 
constraints? 

• Is the current task allocation strategy balanced? 
• What impact will workload have on mission performance time and accuracy? 
• What impact will automation have on mission performance time and 

accuracy? 
After you have defined the questions you are trying to answer, you should select your 
dependent and independent variables.  Then, you should design your analysis process.  
After these items are determined, you will be better equipped to design a model that will 
be responsive to your analytical need. 
 
It is also much easier to debug a model if you add parameters to it in an incremental 
fashion.  In other words, you should begin by identifying the mission as a VACP mission. 
Lay out the network diagram, and then add task times.  Next, execute the model to be 
sure the branching logic is running the way you expect.  If everything is working in the 
way you intended, then you can go back and add the Advanced Workload information. 
Run the model again to check that your workload outputs are explainable.  If you have 
defined workload management strategies, IMPRINT will automatically implement the 
workload management strategies you have chosen by assisting in removing all points of 
overload. 
 
It is often difficult to find sources of data for this type of model.  While IMPRINT can 
provide you some help in this area (e.g., libraries of existing models, inclusion of human 
performance micromodels), you will need to try identifying sources of data.  You may be 
able to get some time or accuracy data from the Operational Requirements Document 
(ORD) of your system, test and evaluation reports of a predecessor, but similar system, or 
from subject matter experts on your system.  Workload data are particularly difficult to 
get, especially for the Advanced Workload method.  Your system design must be fairly 
mature (i.e., at least through Acquisition Milestone 1) before the information you need 
regarding resources and interfaces, and their assignment to specific tasks is available.  
After you feel you have a comfortable understanding of the crew station design, you can 
use benchmarked workload scales to make single task demand workload assignments.  
These scales are quite descriptive and have been proven to be very reliable when used by 
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people that are familiar with the system and the tasks.  Similar assistance is available 
within IMPRINT when you assign conflict values.  However, we do want to emphasize 
that the Advanced Workload method is intended to be used when your design is further 
along and you are attempting to answer very detailed workload questions.  If your design 
is not mature enough to specify the controls and displays in your crew station, we 
recommend you use the VACP workload technique. 
 
If data elements exist for which you do not have any existing data, we recommend that 
you identify the most likely and worst case values for these elements.  You can then run 
the IMPRINT model iteratively to determine how sensitive the model results are to the 
variability of these data items.  If the model is not very sensitive to the values in question, 
then you probably do not need to invest a lot of resources in finding better data.  If the 
model is very sensitive, then you can either work to improve the quality of your data, or 
you can provide a decision maker with information on the most likely and worst case 
results. 

Special Guidance 
The Advanced Workload method can dynamically affect simulated mission performance 
through the use of Workload Management Strategies.  In other words, if you have high 
workload during a portion of your mission, there can be an associated impact on task 
time, accuracy, or sequence.   
 
If you want to perform an Advanced Workload analysis, your mission is limited to two 
levels of task network.  The mission is composed of a network of functions.  The 
functions are each composed of a network of tasks.  You can not mix functions and tasks 
on the same level, and you can not have more than two levels.  Additionally, because 
advanced workload has moderator functions of its own (under the Crew button), the 
Personnel Characteristics, Training Frequencies, and Stressors portion of IMPRINT does 
not affect performance of an Advanced Workload mission. 
 
An additional issue of significance associated with the Advanced Workload missions has 
to do with multiple decision types.  In the VACP Workload missions, when you 
identified a multiple decision type, you also identified the task at which the multiple 
paths rejoined.  This is necessary so that your multiple streams combine into a single 
stream at the proper point in the task network.  This process is discussed in detail in 
Chapter 3, “Using IMPRINT” in the User’s Manual.  While this process is easy for the 
user, it does impose some restrictions on how you can lay out the task network.  In the 
Advanced Workload method, we have removed all restrictions on the layout of the 
network itself.  However, this increase in flexibility requires that you enter your own 
logic to rejoin multiple paths at the proper point in the network.  This logic will typically 
reside in a task’s release condition, beginning effect, and ending effect.  For more 
information, please refer to Chapter 3, “Using IMPRINT” in the IMPRINT User’s 
Manual. 
 
If you want to refer to specific MOS’s in your analysis, you must first go to the Define 
Soldiers menu option and add MOS’s to your analysis.  You can do this by either 



IMPRINT Version 7 

 
Analysis Guide 

17

copying from an existing library system, or by accessing the directory of MOS’s that is 
provided in the Define Soldiers capability.  This process is described in Chapter 6, 
“Soldier Characteristics” in this Analysis Guide. 

Data Requirements 
The data in an IMPRINT Advanced Workload analysis are hierarchically organized.  
Below, we describe the data elements, and indicate which are required, and which are 
optional.  You should be aware that in IMPRINT, we attempt to provide defaults for 
every data element that is required.  Unfortunately, in the Advanced Workload analysis 
method, it is not possible to provide meaningful default values for every item you need.  
For this reason, if you begin an analysis as an Advanced Workload mission, you must 
enter the Operator and Crew Station Workload data (found under the Options menu 
item) before the model will run.  If you attempt to run the model with incomplete 
information, IMPRINT will give you an error message. 
 
Note that each data element is defined in the glossary provided in the IMPRINT User’s 
Guide. 
 

IMPRINT Level Data Element Required? Default Value
Analysis Name Yes  
Analysis  Version Yes  
Analysis Description No  
Mission Name Yes  
Mission Time Standard No 00:00:00.00 
Mission Time Criterion No 0.00 
Mission Accuracy Criterion No 0.00 
Mission Description No  
Mission Criterion No 0.00 
Crew Station Interface List Yes  
Crew Station Resource and Interface Pairs Yes  
Operator  Resource List Yes Visual, 

Auditory, 
Motor, 
Cognitive, 
Speech 

Operator Workload Management 
Strategies 

No A 

Function Name Yes Unnamed # 
Function Time Standard No 00:00:00.00 
Function  Criterion No 0.00 
Function Branching Logic Yes  
Task Name Yes Unnamed # 
Task Time Standard No 00:00:00.00 
Task  Accuracy Standard No 0.00 Percent 
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Steps Correct 
Task Estimated Time Yes 00:00:00.00 
Task Time Standard Deviation No 00:00:00.00 
Task Time Distribution No Normal 
Task Estimated Accuracy No 0.00 
Task Failure Consequences Yes No Effect 
Task Operator Assignments Yes CrewMember 1
Task Single Task Demand 

Workload Ratings 
Yes  

Task Branching Logic Yes  
Workload Channels Conflict Values Yes 0.0 

Analysis Steps 
In this document, we describe the steps required to perform an Advanced Workload 
analysis.  You can find a detailed description of how to perform each step in Chapter 3, 
“Using IMPRINT” of the IMPRINT User’s Guide.  Additionally, please be aware that the 
sequence of steps provided in this document are often just one method of performing the 
analysis.  As with most Windows products, the same operations can often be performed 
just as effectively in a different order. 
 
1. Begin a new analysis - Open IMPRINT.  From the File menu, choose New.  You will 

see a dialog box in which you must enter an Analysis Name and Version.  Once 
entered, choose OK. 

 
2. Define Mission - From the Define menu, choose System Mission.  You will see a 

dialog box that lists the missions that currently exist for your analysis. 
 
3. Add a new mission - Use the Add button.  Enter a mission name. 
 
4. Enter performance standards - Highlight the mission you just added, and press the 

Open button.  You will see the Mission Information dialog.  If you want IMPRINT to 
compare the predicted performance to the required mission performance, then you 
must enter the mission level performance standards on this dialog.  If you do not want 
this comparison, then you can leave all the text boxes with the default information.  
Set the radio button at the bottom of the dialog to Advanced Workload Analysis. 

 
5. Enter the list of crew members for your system - Click on the Crew button on the 

Mission Information dialog.  Enter the names of the crew members or automation 
devices that will be assigned to perform the tasks in your mission.  If desired, you can 
also use this interface to set some performance moderators for task time and accuracy 
based on operator experience, fatigue, and aptitude.  Click OK to return to the 
Mission Information dialog. 

 
6. Go to the task network diagram - Press the Functions + Tasks button to get to the list 

of functions and tasks at the top level of your mission.  You can enter the functions 



IMPRINT Version 7 

 
Analysis Guide 

19

and tasks using these lists, or you can proceed to the network diagram and use the 
drawing space to draw your network. 

 
7. Draw a network to show task sequence - Press the Network Diagram button.  The 

network diagram will be blank except for the start and end functions that are required 
in each mission.  Use the tool bar and select the Function or Task tool.  Click on the 
network workspace to place the new node.  Use the tool bar and select the Path tool.  
Draw paths between your nodes to show the sequence of the tasks and functions.  For 
more detailed information on what each tool on the tool bar is used for, and how to 
navigate around the network, access IMPRINT on-line help, or see the IMPRINT 
User’s Guide.  Remember that in an Advanced Workload mission, you are limited to 
two levels of the task network.  You must have only functions at the top level and 
only tasks at the second level.  You can not mix functions and tasks in the same level. 

 
8. Enter task data - Double click on each task node to view the task information dialog.  

You will notice that this dialog has tabs along the bottom edge that enable you to 
view data that are attached to each task in your mission.  For this example, we are 
interested in information on the Timing and Accuracy tab and on the Crew Assgn 
tab.  Workload assignments will be done later, using dialogs that are accessed under 
the Options menu. 

 
9. Enter time and accuracy predictions - If you want IMPRINT to compare predicted 

performance to required performance at the task level, you must enter the Time and 
Accuracy Standards and Criteria.  In particular, we recommend that you enter the 
accuracy standard and measure so that you will document what you mean by 
“accurate performance” on this task.  This will be helpful to other people who review 
your mission and it can also be helpful to you when you attempt to estimate the 
probability of task success.  It is important that you enter the Estimated Task Time 
and Estimated Task Accuracy data elements.  These data elements are used to drive 
the mission simulation model.  You can use the Previous and Next buttons to move 
through the tasks within each function of your mission.  Enter these data for every 
task in your mission.  

 
10. Assign operators to your tasks - Click on the Crew Assgn tab for each task.  Use the 

spreadsheet to assign primary operators for each of your tasks.  Assign contingency 
operators for any tasks in which other crewmembers have access to the controls and 
displays needed to perform the tasks and for which they have the training and 
decision authority to perform the task.  You will notice that all the tasks are listed, 
and you do not need the Previous and Next buttons to move through the tasks within 
each function of your mission.  You can exit out of the network diagram by using the 
Close box on the network drawing window.  Use the OK buttons to return to the top 
level of the mission.  IMPRINT will prompt you to save the network diagram. 

 
11. Save your mission - Use the Save command on the File menu to save your data.  We 

strongly recommend that you use this command often during your IMPRINT session. 
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12. Enter Workload Management Strategies - Access the Options menu, and choose the 
Workload Management Strategies menu item.  This capability enables you to 
define the workload threshold for each operator, and how each operator will respond 
when they hit a point of high workload.  The default workload management strategy 
indicates that the operators will continue doing all tasks at the same time.  However, 
as you can see from the interface, you can set a workload management strategy for an 
operator so that it will reallocate tasks to another crewmember, dump tasks, or 
serialize tasks.  We suggest that you first run your Advanced Mission with the default 
workload management strategy.  After you are convinced that your model is running 
correctly, you can begin to implement other strategies and study their effects. 

 
13. Define Resource and Interfaces - The process of defining the workload imposed by 

each task in the mission is rather extensive for Advanced Workload.  There are five 
steps to the process and they can all be found under the Workload and Crewstation 
Parameters item on the Options menu.  Access the first step by selecting Define 
Resources and Interfaces from the cascading menu.  This dialog shows a list of 
human resources (similar to VACP channels) on the left side of the screen.  This list 
will contain five default resources (auditory, visual, motor, cognitive, speech).  You 
can add up to five more to this list.  The list on the right side of the screen is the list 
of controls and displays in your crew station.  Use the Add button to add your 
interfaces to the list.  We recommend that you define your interfaces at a high level to 
begin this analysis.  Later, if necessary, you can break them into more detail.  You 
will see in the upcoming interfaces that the number of interfaces you enter is a 
multiplier in the amount of data you must enter in subsequent screens.  Examples of 
resources are “Control Stick” and “Visual Display.”  When you have entered all your 
resources, use the OK button to exit. 

 
14. Define Resource/Interface Channels - Access the second step on the cascading menu 

under the Workload and Crewstation Parameters item on the Options menu.  This 
step is called Define Resources/Interface Channels.  For each crew member in the 
mission, you will form pairs between the resources and interfaces you identified 
under Define Resources and Interfaces.  This screen appears as a large matrix with 
interfaces down the first column and the resources across the top row.  The cells are 
shown as boxes.  The spreadsheet scrolls to the left and right and up and down if 
necessary.  Click on the cell in the row and column corresponding to the interface 
name and the resource name that will be used together (e.g., Visual and Visual 
Display).  IMPRINT will change marked cells to unmarked cells and vice versa.  You 
can assign each interface up to five resources by marking cells in the spreadsheet.  
For every interface that the selected crew member utilizes in performing either 
primary or contingency tasks you should assign at least one resource.  Once you have 
assigned the resource interface pairs for one operator you can select another operator 
to assign channels using the Next and Previous buttons. 

 
15. Assign Resource/Interface Channels to Tasks - Access the third step on the cascading 

menu under the Workload and Crewstation Parameters item on the Options menu.  
This step is called Assign Resources/Interface Channels to Tasks.  For each 
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crewmember in the mission you will identify the resource/interface channels that are 
used in performing each task.  Each task may require more than one 
resource/interface channel.  Your entries will be used to structure the multiple 
resource theory workload analysis performed by IMPRINT during model execution.  
The window displays a spreadsheet interface with task names displayed down the left 
most column and resource/interface channels displayed across the top.  The tasks are 
grouped by function and the channels are grouped by resource.  Only those tasks that 
were assigned to the crew member as either a primary task or a contingency task are 
displayed.  The cells are shown as check boxes.  Any previous task and channel 
assignments are indicated by check marks in the cells.  The spreadsheet scrolls left 
and right and up and down if necessary.  To mark or unmark a channel as being 
utilized when the operator is performing a task, click on the cell in the row and 
column corresponding to the task name and the channel name, respectively.  
IMPRINT will change an unassigned task/channel to an assigned task/channel and 
vice versa.  Each task can be assigned to up to five resource/interface channels.  Once 
every task has been assigned to at least one resource/interface channel, you can select 
another operator using the Prev and Next buttons. 

 
16. Assign Single Task Demands - Access the fourth step on the cascading menu under 

the Workload and Crewstation Parameters item on the Options menu.  This step 
is called Assign Single Task Demands.  For each crew member in the mission you 
will enter single task demand values. These values will be used to compute the first 
order workload components during model execution.  The values should indicate the 
relative demand on each channel when performing a task.  The window displays a 
spreadsheet with the task names displayed down the left most column and the 
resource/interface channels displayed across the top.  The tasks are grouped by 
function and the channels are grouped by resource.  Only those tasks that were 
assigned to the crew member as either a primary or contingency task are displayed.  
Cells that require a demand value to be entered are shown as boxes.  Any demand 
values previously entered are displayed in the cells.  The default demand value is 
zero.  The spreadsheet scrolls left and right and up and down if necessary.  To enter a 
demand value automatically, double click the mouse in the cell that corresponds to 
the desired task and channel.  Note: Automatic entry can only be used if the channel 
involves one of the five default resources (visual, auditory, motor, speech, or 
cognitive).  If you defined resources in addition to the default resources, you will not 
have the automatic entry option, you will have to manually enter the demand value.  
In automatic mode, IMPRINT recommends a demand value.  In manual mode, you 
must enter a demand value.  To enter a demand value manually, click once in the 
demand field and use the numeric, backspace, and delete keys to manually enter a 
value.  Once you have assigned demand values for all operators, either manually or 
automatically, click on the OK button. 

 
17. Assign Channel Conflict Values - Access the final step on the cascading menu under 

the Workload and Crewstation Parameters item on the Options menu.  This step 
is called Assign Channel Conflict Values.  For each crew member in the mission 
you need to enter channel conflict values.  These values will be used to compute the 
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second and third order workload components during model execution.  Conflict 
values range from 0.0 to 1.0.  A conflict value of 0.0 means that the two channels do 
not interfere with each other at all.  A conflict value of 1.0 means that the two 
channels cannot be utilized at the same time.  IMPRINT has two modes available to 
you for assigning the conflict values.  In automatic mode, IMPRINT recommends a 
conflict value.  In manual mode, you enter a value from the keyboard.  Automatic 
mode is only available for channels that utilize one of the five basic resources (visual, 
auditory, motor, speech, and cognitive).  Channels that utilize other resources must 
have conflict values manually entered.  The Assign Channel Conflict Values window 
displays a spreadsheet with the resource/interface channels displayed both down the 
left column and across the top.  The channels are grouped by resource.  The interface 
names listed down the left column are displayed in boxes if they are potential 
candidates for automatic entry.  The cells in the spreadsheet are displayed as boxes.  
Any previously defined conflict values are displayed in the cells.  The default conflict 
value is 0.0.  To enter a conflict value in automatic mode, click on a interface name in 
the left column that is surrounded by a box.  To manually enter a conflict value, click 
on a cell in the spreadsheet. 

 
18. Execute the Operations Mission - Access the Execute menu, and select the 

Operations Model option.  Notice that you can vary the number of times you want to 
run the mission model and the random number seed.  Press the Run Model button.  
When the model is finished (it should run very quickly), you will be reminded that 
you can access the results using the Reports menu. 

 
19. View Operator Workload and Overload Reports - Access the Reports menu in 

IMPRINT and select the Operations Model menu item.  Highlight the Operator 
Workload and Overload Reports, and press the Reports button.  The Operator 
Workload Report will provide a tabular list of each operator workload every time any 
task began or ended in the mission.  The Operator Overload Report will list every 
time during the mission that any operator was in overload.  It provides details of each 
component of the workload score and also indicates which functions and tasks were 
executing at the time that overload occurred.  There are several other reports that 
contain different aspects of the workload results, but these two reports are the most 
indicative of the amount of overload that your operators experienced. 

 
20. If any overload conditions existed in your mission model, you can take several 

different paths to resolve these overloads.  You can either return to the tasks 
themselves and manually reassign them to different operators, you can change the 
mission network to represent a change in the process, you can return to the Workload 
Management Strategies and select a strategy that reallocates tasks automatically, or 
you can redesign the way the task is performed (either by adjusting the resources and 
interfaces that are used, or through changing the single task demands).  This process 
of alleviating overload conditions typically requires an iterative approach that 
consists of making changes, and repeating the execution of the model in order to 
study the effect that the changes had on overall mission performance.  We 
recommend that you save the results of your work often, and use the Duplicate 
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Mission capability to make copies of your mission whenever you have reached a 
point in your iterative process that you would like to document. 

 
We would like to emphasize that the Advanced Workload capability in IMPRINT is most 
useful for analyses in which the system design is reasonably mature.  We also 
recommend that you familiarize yourself with the Multiple Resource Theory of 
Workload2 prior to beginning this type of analysis. 

                                                 
2 Wickens, C.D., Yeh, Y-Y, 1986, A Multiple Resource Model of Workload Prediction and 
Assessment.  In Proceedings of the IEEE Conference on Systems, Man, and Cybernetics (Atlanta, 
Georgia). 
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Chapter 4 - Maintenance Manpower Requirements 

Goals and Results 
One of the primary objectives of the Define Equipment module in IMPRINT is to help 
you estimate maintenance man-hour requirements for your system.  This module lets you 
enter parameters that control such items as the maintenance manpower pools, the spare 
availability and the combat damage potential.  These parameters, coupled with a mission 
schedule and the data describing the maintenance actions that your system may need, are 
combined in a stochastic maintenance simulation.  The primary purpose of the simulation 
is to predict the maintenance man-hours required to attain an acceptable system 
availability. 
 
The results of the simulation include maintenance manpower requirements by MOS and 
skill level as well as by maintenance organization level.  The results are provided at a 
summary level, as well as on a daily level for the length of the simulation run.  As a result 
of this analysis, other results such as predicted Reliability, Availability, and 
Maintainability (RAM) of your system, are also generated and are available. 

Mental Model 
The maintenance analysis capability consists of a “canned” simulation model that is 
driven by data you enter in IMPRINT.  In the following paragraphs, we provide a very 
general description of how the model works.  Details as to how the process works can be 
found in Chapter 5, “Overview of the IMPRINT Maintenance Model,” in the IMPRINT 
User’s Manual.  
 
The Maintenance Analysis model predicts manpower requirements by simulating the 
maintenance requirements of a unit as the systems are sent out on missions, then to 
maintenance (as required), and then placed back into a pool of available systems.  This 
process repeats for the duration of your scenario.  There are, of course, a number of 
complexities involved in this process.  For instance, when a system comes into 
maintenance, it is prioritized and scheduled for repair based on the pools of maintainers 
with specific specialties available in the particular maintenance level needed.  Therefore, 
if you have very tightly constrained manpower pools, the maintenance will take longer, 
since fewer repairs can be performed in parallel.  This will have an adverse effect on the 
system availability.  If the system is not available to be sent out on other missions, it will 
actually accrue less usage because it is in maintenance, rather than performing missions 
on the battlefield.  Oddly enough, this will result in less maintenance since the 
components are not accruing as much wear and tear.   
 
Other issues that affect the maintenance system include spare availability, combat 
damage, maintenance shifting, and the criticality of individual component failures.  In the 
Analysis Steps provided below, we discuss some of these issues.  If you are interested in 
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the details of how the model works, please refer to Chapter 3, “Using IMPRINT” in the 
User’s Manual. 
 
You can also think of the process of developing a maintenance analysis, running it, and 
analyzing results in much the same way you would think of designing, executing, and 
analyzing an experiment.  In this vein, you should first determine what questions you 
want to answer with this analysis.  The maintenance manpower analysis capability can 
answer questions such as: 

• How many people of each specialty do I need in order to meet the system 
availability requirement? 

• Which pieces of equipment (i.e., subsystems) are the high drivers for 
maintenance? 

• How should each organizational level be staffed? 
• How sensitive is my maintenance manpower requirement to the failure rates 

of individual components? 
After you have defined the questions you are trying to answer, you should select your 
dependent and independent variables.  Then, you should design your analysis process.  
After these items are determined, you will be better equipped to conduct a study that will 
be responsive to your analytical need. 
 
To conduct an IMPRINT analysis of the maintenance man-hour requirements to support 
a particular system, you will need to perform three basic activities:   
 
1. You will need to describe the maintenance requirements for the system by 

specifying the following information for each component system: 
a) how often the component needs to be maintained (i.e., rounds fired, time 

operated) 
b) the type of maintenance task that needs to be performed (remove & 

replace, repair, inspect, troubleshoot, etc.) 
c) the type and number of maintainers that are needed to perform the 

maintenance task 
d) how long it will take to perform each maintenance task 
e) whether the maintenance is scheduled or unscheduled 
f) the maintenance organizational type at which the task needs to be 

performed (e.g., Organization (ORG), Direct Support (DS), General 
Support(GS)) 

g) whether a contact team could perform the maintenance 
 
2. The next activity you will perform will be to build a simulation scenario defining 

the conditions that will be used for the system you are modeling, and the amount 
of usage the components in each system will incur.  System usage and 
probabilities for combat damage will be determined by missions that you will 
define for the scenario.  Each scenario can contain multiple missions.   
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3. The final activity you will perform in preparation for the IMPRINT maintenance 
simulation run will be to define the unit configuration and support parameters for 
each scenario.  These parameters include: 
a) Operational crew (per system) - This is an optional parameter, and the 

information defaults to an empty set of operational crew members. 
b) Maintenance shift manning (size, type) - This parameter defaults to the 

minimum possible shift manning, as well as one shift per day that is eight 
hours long.  IMPRINT calculates the minimum shift manning by 
examining each maintenance task to find the minimum number of people 
in each specialty that will enable any given task to be performed. 

c) Spare parts (availability, wait times) - This is also an optional parameter 
and is specified at the subsystem level.  This parameter defaults to 100% 
availability, and a zero wait time. 

 
If you are using IMPRINT to evaluate the maintenance requirements for a proposed new 
system in the acquisition cycle, you can enter the component maintenance parameters 
from scratch or from a system design.  However, it is more likely that you will begin by 
copying maintenance parameters from a similar library system and then modifying 
existing components and/or adding new components to reflect the system you are trying 
to evaluate.  If you are using IMPRINT for a different purpose, such as unit design, you 
may want to simply copy a library system and use it as is.  You can use the same 
components and maintenance actions and modify only the types of maintainers, 
maintenance levels or other parameters for the existing components. 
 
You may be able to get some maintenance task data from the system contractor.  Often, 
contractors are required to deliver Logistics Support Analysis Records, also referred to as 
“LSA data.”  IMPRINT will import these data, and automatically generate the database 
of maintenance task parameters for you if you have access to LSA data.  For more 
information on this capability, refer to Chapter 3, “Using IMPRINT” in the IMPRINT 
User’s Manual. 
 
As mentioned above, the maintenance analysis also requires a mission schedule, or 
operational profile.  This information is used to determine the intensity of the scenario.  
The intensity, or operating tempo, drives the distance the system travels, the number of 
rounds each weapon system fires, and the number of operating hours that are accrued 
during each day of the scenario.  This information, in turn, controls when the individual 
components will fail.  Often, data that help define the operational profile are available in 
the ORD of your system, test and evaluation reports of a predecessor, but similar system, 
or from subject matter experts on your system.  If data elements exist for which you do 
not have any existing data, we recommend that you identify the most likely and worst 
case values for these elements.  You can then run the IMPRINT model iteratively to 
determine how sensitive the maintenance manpower results are to the variability of these 
data items.  If the results are not very sensitive to the values in question, then you 
probably do not need to invest a lot of resources in finding better data.  If the results are 
very sensitive, then you can either work to improve the quality of your data, or you can 
provide a decision maker with information on the most likely and worst case results. 
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Special Guidance 
There are a few limitations in the maintenance manpower analysis capability that will 
affect your results.  You should first be aware that the model assumes that all Unit level 
maintenance is performed “On Equipment.”  This means that the system will not be 
considered “available” to be sent out on other missions until all Unit level maintenance is 
completed.  You can determine whether Direct Support (DS) (or second level) 
maintenance is performed either “On Equipment” or “Off Equipment” for each individual 
maintenance action.  The model assumes that all General Support (GS) (or third level) 
maintenance is performed “Off Equipment.”  Off Equipment maintenance means that the 
system will be considered available before the repairs are complete because it is 
modeling maintenance as though the component has been removed from the system for 
repair. 
 
An additional assumption made in the model is that the model prioritizes maintenance so 
that the system with the smallest amount of total repair time is repaired first.  All Unit 
level maintenance must be completed prior to beginning any DS level maintenance.  
Similarly, all DS level maintenance must be completed prior to beginning any GS level 
maintenance. 
 
Spare part availability is only considered for Remove and Replace Repair Tasks that are 
being performed at the Unit Level.  All other repairs are performed independent of the 
spare parts availability data. 
 
One very important aspect of the maintenance manpower analysis capability is the 
concept of failure clocks.  IMPRINT’s maintenance model is very high fidelity.  Each 
component of each system in your analysis has its own failure clock.  Failures are 
predicted by individually comparing the accrued usage on each component to an 
exponential statistical distribution, with a mean that is equal to the component’s failure 
clock.  This provides a realistic estimation of maintenance requirements throughout the 
scenario by simulating a failure time that is randomly distributed. 

Data Requirements 
The data in an IMPRINT maintenance analysis are hierarchically organized.  The 
equipment is composed of subsystems.  Subsystems are constructed with components.  
Each component has one or more repair tasks.  Also each equipment definition is 
associated with at least one scenario.  Scenarios are composed of mission segments.   
 
Below, we describe the data elements, and indicate which are required, and which are 
optional.  You should be aware that in IMPRINT, we attempt to provide defaults for 
every data element that is required.  For this reason, even though a data element is 
“required” you may not actually have to enter it yourself.   
 
Note that each data element is defined in the glossary provided in the IMPRINT User’s 
Guide. 
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IMPRINT 
Level 

Data Element Required? Default Value 

Analysis Name Yes  
Analysis  Version Yes  
Analysis Description No  
Subsystem Name Yes  
Subsystem Equipment Type Yes Mobility 
Component Name Yes  
Repair Task Name Yes  
Repair Task Mean Operational Unit Between 

Failure 
Yes 999999 

Repair Task Mean Time to Repair (MTTR) Yes 0.00 
Repair Task MTTR Standard Deviation No 0.00 
Repair Task MTTR Distribution No Normal 
Repair Task  MOS and Number  Yes  
Repair Task Organizational Level Yes ORG 
Repair Task Contact Team No No 
Repair Task Probability of Abort Yes 0.00 
Scenario Name Yes  
Scenario Shift Manning Yes 999 
Scenario Travel Times No 0.00 
Scenario Spare Availability No 100.0 
Scenario Number of Systems Yes 1 
Scenario  Length Yes 1 Day 
Segment Name Yes  
Segment Start Time Yes 00:00:00.00 
Segment Start Day Yes 1 
Segment Cancellation Time No 00:00:00.00 
Segment  Duration Yes 04:00:00.00 
Segment  Priority No 0 
Segment Minimum Number of Systems Yes 1 
Segment Maximum Number of Systems Yes 1 
Segment Time Between Departure Groups No 00:00:00.00 
Segment Number per Departure Group No 0 
Segment Repeating Data No  
Segment Consumables Yes 0 
Segment Combat Damage No 0.00 
 
Combat damage estimates are particularly difficult to make, and therefore deserve special 
discussion.  The primary sources of combat data are the U.S. Army Concepts Analysis 
Agency (CAA), the U.S. Army Materiel and Systems Analysis Activity (AMSAA), the 
U.S. Army Training and Doctrine Command (TRADOC), and Combined Arms subject 
matter experts.   
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Analysis Steps 
In this document, we describe the steps required to perform a maintenance manpower 
analysis.  You can find a detailed description of how to perform each step in Chapter 3, 
“Using IMPRINT,” of the IMPRINT User’s Guide.  Additionally, please be aware that 
the sequence of steps provided in this document are often just one method of performing 
the analysis.  As with most Windows products, the same operations can often be 
performed just as effectively in a different order. 
 
1. Begin a new analysis - Open IMPRINT.  From the File menu, choose New.  You will 

see a dialog box in which you must enter an Analysis Name and Version.  Once 
entered, choose OK. 

 
2. Define Soldiers - Begin by entering the MOS’s for the soldiers that will be assigned 

to your new system.  From the Define menu, choose Soldiers.  Use the Add button to 
enter a list of MOS’s that will maintain your system.  Click on the OK button when 
you are finished. 

 
3. Define Mission - From the Define menu, choose Equipment.  You will see a dialog 

box that contains your Analysis Name, Version and Description.  Click on the 
Evaluate Design button.  You will see a dialog that contains a list of the subsystems 
within your system. 

 
4. Add a new subsystem - Use the Add button.  Enter a subsystem name.  Use the 

combo box in the second column to indicate whether this subsystem is an 
Armaments, Mobility, or Other type.  This indication determines how usage will be 
accrued to the components in the subsystem.  Armaments subsystems accrue usage 
(and, therefore, fail) based on the number of rounds fired.  Mobility subsystems 
accrue usage based on the distance traveled.  Other subsystems accrue usage based on 
operating time.  To begin entering components for your subsystem, select the 
subsystem and Click on the Open button. 

 
5. Add the components in your new subsystem - Use the Add button.  Enter a 

component name.  To begin adding repair tasks for your component, select the 
component, and click on the List Repair Tasks button. 

 
6. Enter repair task data - The component you selected will be listed at the top of the 

dialog box.  Use the Add button to begin entering the repair tasks that will need to be 
performed on this component.  You can choose from a set of task names.  As you 
enter repair tasks, each repair task will be added to the spreadsheet.  You can then 
move across the columns of the spreadsheet and set the maintenance parameters.  The 
first and second column will be filled in for you based on the repair task that you 
chose.  The third column is the organizational level at which the task will be 
performed.  The next six columns are used to enter the MOS, skill level, and the 
crew size needed to perform the task.  Notice that you enter two different MOS’s (or 
the same MOS with two different skill levels).  IMPRINT will make both these 
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specialties busy for the entire length of the repair task.  So if you have a repair task 
that doesn’t require the attention of both MOS’ for the entire length, you should break 
it into two tasks.  The next column is the Mean Operational Unit Between Failure 
(MOUBF).  This is the number that IMPRINT uses to predict when the repair task 
will be needed.  The MOUBF is more typically called a Mean Time Between Failure 
(MTBF) in maintenance modeling literature, and is the inverse of the failure rate.  
The next three columns compose the specification of how long it will take to perform 
the maintenance task.  The first of these columns is the Mean Time to Repair 
(MTTR).  This value is in hours. This is a value representing the average time it 
takes to perform this maintenance action.  This value and the standard deviation for 
the repair time (SD MTTR) are used to generate a simulated time for this 
maintenance action from the statistical distribution you choose in the next column.  
The final two columns include the probability of whether this repair task will cause 
an ongoing mission to abort (Abort %) and an indication of whether this task could 
be performed by a contact team.  Enter the repair data for each task in for your 
component.  You can use the Next and Previous buttons to move through all the 
components in your subsystem.  Click on the OK button when you have finished. 

 
7. Enter the remainder of your equipment data - Repeat steps 3-5 until you have entered 

a full description of your equipment.  Once you have completed these steps, most of 
your work is done.  You can exercise this equipment description against a wide 
variety of different scenarios with very little effort. 

 
8. Save your results - Use either the Save tool on the IMPRINT tool bar or the Save 

command under the File menu to save your results.  We recommend that you save 
often throughout your IMPRINT session. 

 
9. Enter a scenario - Return to the Evaluate Design dialog, and click on the Scenarios 

button.  This will open a list of existing scenarios.  Use the Add button to add a new 
scenario. 

 
10. Enter scenario data - Highlight a scenario name and click on the Open button.  From 

this new dialog, you can decompose your scenario into segments, as well as enter 
Maintenance Crew Manning data, Travel Time data, and Spare data.   

 
11. Decompose the scenario into segments - Click on the Segments button.  This will 

open a dialog with a list of the mission segments.  Use the Add button to add 
segments. 

 
12. Enter the mission segment data - Highlight a segment and click on the Operational 

Profile button.  This will open a dialog that contains all of the data items associated 
with a mission segment.  Starting at the top of the dialog, enter the segment start time 
and day.  If you want the mission segment to be scheduled for departure at 0800 on 
the first day of the scenario, then these values would be 08:00:00 and 1.  Next, enter 
the Cancellation time.  If the segment has not departed within this amount of time 
from the Departure Time, then the segment will be canceled.  The next data item is 
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the segment duration.  The data item following that is the segment priority.  This is 
used if two segments are competing for a limited number of available systems.  The 
highest priority segment will be filled first.  The next two data items are the minimum 
and maximum number of systems needed for this segment.  The segment will not be 
canceled if the minimum number of systems are available prior to the departure time 
plus the cancellation time.  If there are enough systems available, the segment will be 
filled with the maximum number of systems.  The next two elements are the number 
per departure group and the time between departures.  These two data items enable 
you to stagger the departures of your systems.  You will also notice that you can set 
this mission segment to repeat periodically throughout the scenario.   

 
13. Enter Combat Damage parameters - Click on the Combat button to enter the 

likelihood that your system will sustain combat damage during this segment, and if 
so, whether the system will be destroyed.  If desired, you can enter the amount of 
time it will take to repair combat damage, or if the system is destroyed, the amount of 
time it will take before the system can be replaced in the Unit’s inventory.  If the 
system undergoes repair due to combat damage, that repair time is NOT attributed to 
a specific subsystem or MOS.  Rather, it is indicated separately in the Combat 
Damage Report.  It will, however, affect system availability.  Click on the OK button 
to return to the segment dialog. 

 
14. Enter Consumable data - Click on the Consumables button to enter the amount of 

rounds your system will fire and the distance it will travel during this mission 
segment.  Also, you can enter the time needed to prepare the system for the segment.  
This is called the Load Time.  This time will only delay the beginning of the segment.  
It will not affect failure rates.  Click on the OK button to return to the segment 
dialog. 

 
15. When you have finished entering these data, you can use the Next and Previous 

buttons to move through the rest of your segments.  Use the OK button to exit back to 
the Scenarios dialog. 

 
16. Enter Maintenance Crew data - Click on the Maintenance Crew button on the 

Scenarios dialog.  In this dialog, you can enter the shifting information and the 
maintenance crew manning information if you want to run your maintenance model 
with a limited maintenance crew.  We recommend that the first time you run your 
maintenance model, you run it in an unconstrained mode.  This will result in a 
maintenance analysis where system availability is maximized (because there will 
always be an unlimited number of soldiers available to maintain the system).  Then, 
after you have satisfied yourself that these results are reasonable, you should return to 
this screen and enter constrained maintenance crews in order to more realistically 
predict maintenance.  Click on the OK button to return to the Scenarios dialog. 

 
17. Save your results - Use either the Save tool on the IMPRINT tool bar or the Save 

command under the File menu to save your results.  As mentioned above, we 
recommend that you save often throughout your IMPRINT session. 
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18. Execute the maintenance model - Access the Execute menu, and select the 

Maintenance Model option.  Notice that you can vary the length of the run and the 
random number seed.  You also must enter the number of systems that you want to 
include in your maintenance model.  Remember to include enough systems so that 
you can meet the minimum number on your segments.  Finally, notice that there is a 
check box on this screen to indicate whether you want to turn the Crew Limits on.  If 
you have entered maintenance crew sizes, yet you want to run the maintenance model 
in an unconstrained mode, just make sure that you “uncheck” this box.  Press the Run 
Model button.  When the model is finished, you will be reminded that you can access 
the results using the Reports menu. 

 
19. View Maintenance Summary, Headcount Frequency, and Maintenance Man-hour 

Reports - Access the Reports menu in IMPRINT and select the Maintenance Model 
menu item.  Highlight the Maintenance Summary, Headcount Frequency, and 
Maintenance Man-hour Reports, and press the Reports button.  The Maintenance 
Summary Report will include the total number of operational hours that were 
modeled in your scenario, as well as the sum of the preventive and corrective 
maintenance man-hours expended during the scenario.  The Headcount Frequency 
report Report is a list of the frequency that different crew sizes were used for each 
MOS at each skill level within each organizational level.  If you ran your model in an 
unconstrained mode, you can use this report to help you decide on reasonable 
constraints for each of your maintainers. This report provides a measure of MOS 
utilization.  It illustrates the frequency with which different numbers of people in 
each MOS were used.  The highest bin for which a > 0% utilization is shown will 
never exceed the shift manning levels you set for that MOS and that organizational 
level type.  Additionally, if the highest bin shown has a relatively high frequency, as 
in the example of 20% of the time three people being used, then it is possible that you 
have constrained this MOS so tightly that it is reducing system availability.  Finally, 
the Maintenance Man-hour Report lists the number of man-hours actually expended 
by each MOS and skill level at each organizational level.  This report will help you 
identify the high driver maintainers for your system. 

 
20. Next, you can return to the maintenance manning dialog to change the distribution of 

maintenance manpower in your organization. 
 
21. Rerun the analysis - In order to evaluate the impact of the modified manning, you 

must rerun the analysis and review the reports in order to ensure that your system 
availability is still acceptable. 
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Chapter 5 - System Reliability, Availability and Maintainability 

Goals and Results 
One of the primary objectives of the Define Equipment module in IMPRINT is to help 
you estimate your system's reliability, availability, and maintainability (RAM).  This 
module lets you enter parameters that control such items as the maintenance manpower 
pools, the spare availability and the combat damage potential.  These parameters coupled 
with a mission schedule and the data describing the maintenance actions that your system 
may need are combined in a stochastic maintenance simulation.  The results of this 
analysis are a variety of system-level RAM measures.  These measures are also broken 
down into more detail so that you can identify the high driver subsystems of your 
systems.  Also, as a result of this analysis, other measures such as the maintenance 
manpower requirements by MOS (specialty), skill level, and maintenance level are also 
generated and are available. 

Mental Model 
The maintenance analysis capability consists of a “canned” simulation model that is 
driven by data you enter in IMPRINT.  In the following paragraphs, we provide a very 
general description of how the model works.  Details as to how the process works can be 
found in  Chapter 5, “Overview of the IMPRINT Maintenance Model” in the IMPRINT 
User’s Manual. 
 
The Maintenance Analysis model predicts system RAM by simulating the maintenance 
requirements of a unit as the systems are sent out on missions, then to maintenance (as 
required), and then placed back into a pool of available systems.  This process repeats for 
the duration of your scenario.  There are, of course, a number of complexities involved in 
this process.  For instance, when a system comes into maintenance, it is prioritized and 
scheduled for repair based on the pools of maintainers with specific specialties available 
in the needed maintenance level.  Therefore, if you have very tightly constrained 
manpower pools, the maintenance will take longer, since fewer repairs can be performed 
in parallel.  This will have an adverse effect on the system availability.  If the system is 
not available to be sent out on other missions, it will actually accrue less usage (because 
it is in maintenance, rather than performing missions on the battlefield).  Oddly enough, 
this will result in less maintenance, since the components are not accruing as much wear 
and tear.   
 
Other issues that affect the maintenance system include spare availability, combat 
damage, maintenance shifting, and the criticality of individual component failures.  In the 
Analysis Steps provided below, we discuss some of these issues.  If you are interested in 
the details of how the model works, please refer to Chapter 5, “Overview of the 
IMPRINT Maintenance Model” in the User’s Manual. 
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You can think of the process of developing a maintenance analysis, running it, and 
analyzing results in much the same way you would think of designing, executing, and 
analyzing an experiment.  In this vein, you should first determine what questions you 
want to answer with this analysis.  The maintenance manpower analysis capability can 
answer questions such as: 

• How many people of each specialty do I need in order to meet the system 
availability requirement? 

• Which pieces of equipment (i.e., subsystems) are the high drivers for 
maintenance? 

• How does the system availability vary over the duration of a scenario? 
After you have defined the questions you are trying to answer, you should select your 
dependent and independent variables.  Then, you should design your analysis process.  
After these items are determined, you will be better equipped to conduct a study that will 
be responsive to your analytical needs. 
 
To conduct an IMPRINT analysis of the system RAM, you will need to perform three 
basic activities:   
 
1. First, you will need to describe the maintenance requirements for the system by 

specifying the following information for each component system: 
a) how often the component needs to be maintained (i.e., rounds fired, time 

operated) 
b) the type of maintenance task that needs to be performed (remove & 

replace, repair, inspect, troubleshoot, etc.) 
c) the type and number of maintainers that are needed to perform the 

maintenance task 
d) how long it will take to perform each maintenance task 
e) whether the maintenance is scheduled or unscheduled 
f) the maintenance organizational type at which the task needs to be 

performed (e.g., ORG, DS, GS) 
g) whether a contact team could perform the maintenance 

 
2. The next activity that you will perform will be to build a simulation scenario that 

will define the conditions under which the system you are modeling will be used 
and the amount of usage the components in each system will incur.  System usage 
and probabilities for combat damage will be determined by missions that you will 
define for the scenario.  Each scenario can contain multiple missions.   

 
3. The final activity you will perform to prepare for the IMPRINT maintenance 

simulation run will be to define the unit configuration and support parameters for 
each scenario.  These parameters include: 
a) Operational crew (per system) - This is an optional parameter, and the 

information defaults to an empty set of operational crew members. 
b) Maintenance shift manning (size, type) - This parameter defaults to the 

minimum possible shift manning, as well as one shift per day that is eight 
hours long.  IMPRINT calculates the minimum shift manning by 
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examining each maintenance task to find the minimum number of people 
in each specialty that will enable any given task to be performed. 

c) Spare parts (availability, wait times) - This is also an optional parameter 
and is specified at the subsystem level.  This parameter defaults to 100% 
availability, and a zero wait time. 

 
If you are using IMPRINT to evaluate the RAM for a proposed new system in the 
acquisition cycle, you can enter the component maintenance parameters from scratch or 
from a system design.  However, it is more likely that you will begin by copying 
maintenance parameters from a similar library system and then modifying existing 
components and/or adding new components to reflect the system you are trying to 
evaluate.  If you are using IMPRINT for a different purpose, such as unit design, you 
may want to simply copy a library system.  Use the same components and maintenance 
actions and modify only the types of maintainers, maintenance levels or other parameters 
for the existing components. 
 
You may be able to get some maintenance task data from the system contractor.  Often, 
contractors are required to deliver Logistics Support Analysis Records, also referred to as 
“LSA data.”  IMPRINT will import these data, and automatically generate the database 
of maintenance task parameters for you if you have access to LSA data.  For more 
information on this capability, refer to the IMPRINT User’s Manual. 
 
As mentioned above, the maintenance analysis also requires a mission schedule, or 
operational profile.  This information is used to determine the intensity of the scenario.  
The intensity, or operating tempo, drives the distance the system travels, the number of 
rounds each weapon system fires, and the number of operating hours that are accrued 
during each day of the scenario.  This information, in turn, controls when the individual 
components will fail.  Often, data that help define the operational profile are available in 
the Operational Requirements Document (ORD) of your system, test and evaluation 
reports of a predecessor, but similar system, or from subject matter experts on your 
system.  If data elements exist for which you do not have any existing data, we 
recommend that you identify the most likely and worst case values for these elements.  
You can then run the IMPRINT model iteratively to determine how sensitive the 
maintenance manpower results are to the variability of these data items.  If the results are 
not very sensitive to the values in question, then you probably do not need to invest a lot 
of resources in finding better data.  If the results are very sensitive, then you can either 
work to improve the quality of your data, or you can provide a decision maker with 
information on the most likely and worst case results. 

Special Guidance 
There are a few limitations in the system RAM analysis capability that will affect your 
results.  First, you should be aware that the model assumes that all Unit level 
maintenance is performed “On Equipment.”  This means that the system will not be 
considered “available” to be sent out on other missions until all Unit level maintenance is 
completed.  DS and GS (or second and third level maintenance) are assumed to be 
performed “Off Equipment.”  This means that the system will be considered available 
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before the repairs are complete because it is modeling maintenance as though the 
component has been removed from the system for repair. 
 
An additional assumption of the model is that maintenance is prioritized so that the 
system with the smallest amount of total repair time is repaired first.  Also, all Unit level 
maintenance must be completed prior to beginning any DS level maintenance.  Similarly, 
all DS level maintenance must be completed prior to beginning any GS level 
maintenance. 
 
Spare part availability is only considered for Remove and Replace Repair Tasks that are 
being performed at the Unit Level.  All other repairs are performed independent of the 
spare parts availability data. 
 
One very important aspect of the system RAM analysis capability is the concept of 
failure clocks.  IMPRINT’s maintenance model is very high fidelity.  Each component of 
each system in your analysis has its own failure clock.  Failures are predicted by 
individually comparing the accrued usage on each component to its failure clock.  This 
provides a realistic estimation of maintenance requirements throughout the scenario. 

Data Requirements 
The data in an IMPRINT RAM analysis are hierarchically organized.  The equipment is 
composed of subsystems.  Subsystems are composed of components.  Each component 
has one or more repair tasks.  Also each equipment definition is associated with at least 
one scenario.  Scenarios are composed of mission segments.   
 
Below, we describe the data elements, and indicate which are required, and which are 
optional.  You should be aware that in IMPRINT, we attempt to provide defaults for 
every data element that is required.  For this reason, even though a data element is 
“required” you may not actually have to enter it yourself.   
 
Note that each data element is defined in the glossary that is provided in the IMPRINT 
User’s Guide. 
 

IMPRINT 
Level 

Data Element Required? Default Value 

Analysis Name Yes  
Analysis  Version Yes  
Analysis Description No  
Subsystem Name Yes  
Subsystem Equipment Type Yes Mobility 
Component Name Yes  
Repair Task Name Yes  
Repair Task Mean Operational Unit Between 

Failure 
Yes 999999 

Repair Task Mean Time to Repair (MTTR) Yes 0.00 
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Repair Task MTTR Standard Deviation No 0.00 
Repair Task MTTR Distribution No Normal 
Repair Task  MOS and Number  Yes  
Repair Task Organizational Level Yes ORG 
Repair Task Contact Team No No 
Repair Task Probability of Abort Yes 0.00 
Scenario Name Yes  
Scenario Shift Manning Yes 999 
Scenario Travel Times No 0.00 
Scenario Spare Availability No 100.0 
Scenario Number of Systems Yes 1 
Scenario  Length Yes 1 Day 
Segment Name Yes  
Segment Start Time Yes 00:00:00.00 
Segment Start Day Yes 1 
Segment Cancellation Time No 00:00:00.00 
Segment  Duration Yes 04:00:00.00 
Segment  Priority No 0 
Segment Minimum Number of Systems Yes 1 
Segment Maximum Number of Systems Yes 1 
Segment Time Between Departure Groups No 00:00:00.00 
Segment Number per Departure Group No 0 
Segment Repeating Data No  
Segment Consumables Yes 0 
Segment Combat Damage No 0.00 

Analysis Steps 
In this document, we describe the steps required to perform the System RAM analysis.  
You can find a detailed description of how to perform each step in Chapter 3, “Using 
IMPRINT,” of the IMPRINT User’s Guide.  Additionally, please be aware that the 
sequence of steps provided in this document are often just one method of performing the 
analysis.  As with most Windows products, the same operations can often be performed 
just as effectively in a different order. 
 
1. Begin a new analysis - Open IMPRINT.  From the File menu, choose New.  You will 

see a dialog box in which you must enter an Analysis Name and Version.  Once 
entered, choose OK. 

 
2. Define Soldiers - Begin by entering the MOS’s for the soldiers that will be assigned 

to your new system.  From the Define menu, choose Soldiers.  Use the Add button to 
enter a list of MOS’s that will maintain your system.  Click on the OK button when 
you are finished. 
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3. Define Mission - From the Define menu, choose Equipment.  You will see a dialog 
box that contains your Analysis Name, Version and Description.  Click on the 
Evaluate Design button.  You will see a dialog that contains a list of the subsystems 
within your system. 

 
4. Add a new subsystem - Use the Add button.  Enter a subsystem name.  Use the 

combo box in the second column to indicate whether this subsystem is an 
Armaments, Mobility, or Other type.  This indication determines how usage will be 
accrued to the components in the subsystem.  Armaments subsystems accrue usage 
(and, therefore, fail) based on the number of rounds fired.  Mobility subsystems 
accrue usage based on the distance traveled.  Other subsystems accrue usage based on 
operating time.  To begin entering components for your subsystem, select the 
subsystem and Click on the Open button. 

 
5. Add the components to your new subsystem - Use the Add button.  Enter a 

component name.  To begin adding repair tasks for your component, select the 
component, and click on the List Repair Tasks button. 

 
6. Enter repair task data - The component you selected will be listed at the top of the 

dialog box.  Use the Add button to begin entering the repair tasks that will need to be 
performed on this component.  You can choose from a set of task names.  As you 
enter repair tasks, each repair task will be added to the spreadsheet.  You can then 
move across the columns of the spreadsheet and set the maintenance parameters.  The 
first and second column will be filled in for you based on the repair task that you 
chose.  The third column is the organizational level at which the task will be 
performed.  The next six columns are used to enter the MOS, skill level, and the 
crew size needed to perform the task.  Notice that you enter two different MOS’s (or 
the same MOS with two different skill levels).  IMPRINT will make both these 
specialties busy for the entire length of the repair task.  So if you have a repair task 
that doesn’t require the attention of both MOS’ for the entire length, you should break 
it into two tasks.  The next column is the Mean Operational Unit Between Failure 
(MOUBF).  This is the number that IMPRINT uses to predict when the repair task 
will be needed.  The MOUBF is more typically called a MTBF in maintenance 
modeling literature, and is the inverse of the failure rate.  The next three columns 
compose the specification of how long it will take to perform the maintenance task.  
The first of these columns is the Mean Time to Repair (MTTR).  This value is in 
hours. This is a value representing the average time it takes to perform this 
maintenance action.  This value and the standard deviation for the repair time (SD 
MTTR) are used to generate a simulated time for this maintenance action from the 
statistical distribution you choose in the next column.  The final two columns 
include the probability that the need for this repair task will cause an ongoing mission 
to abort (Abort %) and an indication of whether this task could be performed by a 
contact team.  Enter the repair data for each task in for your component.  You can 
use the Next and Previous buttons to move through all the components in your 
subsystem.  Click on the OK button when you have finished. 
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7. Enter the remainder of your equipment data - Repeat steps 3-5 until you have entered 
a full description of your equipment.  Once you have completed these steps, most of 
your work is done.  You can exercise this equipment description against a wide 
variety of different scenarios with very little effort. 

 
8. Save your results - Use either the Save tool on the IMPRINT tool bar or the Save 

command under the File menu to save your results.  We recommend that you save 
often throughout your IMPRINT session. 

 
9. Enter a scenario - Return to the Evaluate Design dialog, and click on the Scenarios 

button.  This will open a list of existing scenarios.  Use the Add button to add a new 
scenario. 

 
10. Enter scenario data - Highlight a scenario name and click on the Open button.  From 

this new dialog, you can decompose your scenario into segments, as well as enter 
Maintenance Crew Manning data, Travel Time Data, and Spare Data.   

 
11. Decompose the scenario into segments - Click on the Segments button.  This will 

open a dialog with a list of the mission segments.  Use the Add button to add 
segments. 

 
12. Enter the mission segment data - Highlight a segment and click on the Operational 

Profile button.  This will open a dialog that contains all of the data items associated 
with a mission segment.  Starting at the top of the dialog, enter the segment start time 
and day.  If you want the mission segment to be scheduled for departure at 0800 on 
the first day of the scenario, then these values would be 08:00:00 and 1.  Next, enter 
the Cancellation time.  If the segment has not departed within this amount of time 
from the Departure Time, then the segment will be canceled.  The next data item is 
the segment duration.  The data item following that is the segment priority.  This is 
used if two segments are competing for a limited number of available systems.  The 
highest priority segment will be filled first.  The next two data items are the minimum 
and maximum number of systems needed for this segment.  The segment will not be 
canceled if the minimum number of systems are available prior to the departure time 
plus the cancellation time.  If there are enough systems available, the segment will be 
filled with the maximum number of systems.  The next two elements are the number 
per departure group and the time between departures.  These two data items enable 
you to stagger the departures of your systems.  You will also notice that you can set 
this mission segment to repeat periodically throughout the scenario.   

 
13. Enter Combat Damage parameters - Click on the Combat button to enter the 

likelihood of your system sustaining combat damage during this segment, and if so, 
whether the system will be destroyed.  If desired, you can enter the amount of time it 
will take to repair combat damage, or if the system is destroyed, the amount of time it 
will take before the system can be replaced in the Unit’s inventory.  If the system 
undergoes repair due to combat damage, that repair time is NOT attributed to a 
specific subsystem or MOS.  Rather, it is reported separately in the Combat Damage 
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Report.  It will, however, affect system availability.  Click on the OK button to return 
to the segment dialog. 

 
14. Enter Consumable data - Click on the Consumables button to enter the amount of 

rounds your system will fire and the distance it will travel during this mission 
segment.  Also, you can enter the time needed to prepare the system for the segment.  
This is called the Load Time.  This time will only delay the beginning of the segment.  
It will not affect failure rates.  Click on the OK button to return to the segment 
dialog. 

 
15. When you have finished entering these data, you can use the Next and Previous 

buttons to move through the rest of your segments.  Use the OK button to exit back to 
the Scenarios dialog. 

 
16. Enter Maintenance Crew data - Click on the Maintenance Crew button on the 

Scenarios dialog.  In this dialog, you can enter the shifting information and the 
maintenance crew manning information, if you want to run your maintenance model 
with a limited maintenance crew.  We recommend that the first time you run your 
maintenance model, you run it in an unconstrained mode.  This will result in a 
maintenance analysis where system availability is maximized (because there will 
always be an unlimited number of soldiers available to maintain the system).  Then, 
after you are satisfied that these results are reasonable, you should return to this 
screen and enter constrained maintenance crews in order to more realistically predict 
maintenance.  Click on the OK button to return to the Scenarios dialog. 

 
17. Save your results - Use either the Save tool on the IMPRINT tool bar or the Save 

command under the File menu to save your results.  As mentioned above, we 
recommend that you save often throughout your IMPRINT session. 

 
18. Execute the maintenance model - Access the Execute menu, and select the 

Maintenance Model option.  Notice that you can vary the length of the run and the 
random number seed.  Also, you must enter the number of systems that you want to 
include in your maintenance model.  Remember to include enough systems so that 
you can meet the minimums on your segments.  Finally, notice that there is a check 
box on this screen to indicate whether you want to turn the Crew Limits on.  If you 
have entered maintenance crew sizes, yet you want to run the maintenance model in 
an unconstrained mode, just make sure that you “uncheck” this box.  Press the Run 
Model button.  When the model is finished, you will be reminded that you can access 
the results using the Reports menu. 

 
19. View Reports - Access the Reports menu in IMPRINT and select the Maintenance 

Model menu item.  You should review the Maintenance Summary, Daily 
Maintenance, Reliability and Availability, Maintenance Hit Matrix, Daily Reliability 
and the Maintainability Report.  You can select one or more reports by clicking on 
and highlighting the appropriate report title.  The maintenance summary report 
contains four data items that summarize the maintenance requirements that were 
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generated during the simulation.  This report includes the average corrective and 
preventive maintenance man-hours that were simulated for each system.  These are 
calculated by taking the total amount of man-hours in each category, and dividing by 
the total number of systems in the scenario.  The average maintenance man-hours 
simulated per operational hour is also included.  This is calculated by dividing the 
sum of the preventive and corrective maintenance manhours by the total operating 
hours.  The Daily Maintenance Report contains the amount of maintenance manhours 
that were simulated at all organizational level types (e.g., ORG, DS, GS) for both 
maintenance types (e.g., preventive, corrective).  The values in this report are totals 
across all systems.  The Reliability and Availability Report has two parts.  The first 
part is the Reliability Summary.  It includes the number of segments requested and 
accomplished during the simulation.  The report also includes measures for the 
number of times systems were requested, and the number of times that those system 
requests were accomplished.  If you had one segment and a maximum of two systems 
assigned to that segment, then that will be reported as "Number of Times Systems 
Requested" = 2.  If only one of the systems actually performed the segment, because 
the other system was either busy or in maintenance, then that will be reported as 
"Number of Times System Requests Accomplished" = 1.  The second part of the 
screen includes an Availability Summary.  The values are calculated as follows: 

• Average inherent availability = ((scenario length in hours x # of systems) 
minus (total clock hours on corrective maintenance)) divided by (scenario 
length in hours x # of systems) 

• Average achieved availability = ((scenario length in hours x # of systems) 
minus (total clock hours on corrective + preventive maintenance)) divided by 
(scenario length in hours x # of systems) 

• Readiness = segments accomplished divided by segments requested 
(Note that inherent and achieved availability consider the total number of days 
simulated in hours (e.g., 365 * 24), minus the number of clock hours spent in 
maintenance.  Therefore, if 2 or more soldiers are working at the same time on the 
same system, it is counted just once.  Similarly, if two maintenance tasks are being 
worked at the same time, it is only counted once).  The Daily Reliability Report 
provides a summary of the number of segments and segment requests generated by 
the simulation for each day of the scenario.  The Maintainability Report contains the 
simulated maintenance manhours per operational hour are included in this report.  
This is calculated by dividing the total manhours of maintenance performed on each 
subsystem by the total number of operational hours of the scenario.  This report will 
provide a measure of your high driver subsystems. 

 
20. If your system did not meet its RAM requirement, then there are a number of 

maintenance parameters you can adjust.  First, you should adjust the intensity of your 
scenario to determine whether this variable is driving the RAM.  You can decrease 
segment duration and the number of segments per scenario to decrease the intensity.  
As an alternative, you can increase the number of maintainers in your crew so that the 
system can be maintained more quickly.   
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21. Rerun the analysis - In order to evaluate the impact of the modified scenario, you 
must rerun the analysis and review the reports in order to ensure that your system 
RAM is now acceptable. 
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Chapter 6 - Soldier Characteristics 

Goals and Results 
If you are interested in determining what types of soldiers (in terms of personnel 
characteristics such as mental aptitude, reading grade level, etc.) may be available to 
operate, maintain, and support a system, you will want to conduct a “Define Soldier” 
analysis.  By the same token, if you want to determine what types of people are currently 
in an MOS or are projected to be in an MOS, you should also use this type of analysis.  
The “Define Soldier” module lets you select MOSs that are likely to be available 
(probably from a predecessor system) to operate and maintain the new system.  It then 
permits you to “project” the MOSs into the future, when the new system will be fielded, 
to obtain estimates on their personnel characteristics.  Since, quite often, the system 
being supported by this analysis will not be fielded until sometime in the future, it is 
important that the personnel characteristics, and thus the performance of the operators 
and maintainers, be related to that time frame rather than now. 
 
The results from the Define Soldier analysis are accessed through the Reports menu in 
IMPRINT.  The reports address the following personnel characteristics by MOS and 
year: 

• Gender (male & female) - Gender is tied very closely to the physical differences 
that may impact performance on selected tasks that a specific specialty (or MOS) 
will require. 

• Education (high school graduate & non high school graduate) - Whether an 
individual is a high school graduate is a good indicator of the individual’s 
trainability and amenability to the discipline required to make it through basic 
training. 

• Test Score Category (I, II, IIIA, IIIB, & IV) - One of the personnel 
characteristics of most interest is Test Score Category.  This is because it is not 
only a good indicator of an individual’s trainability but also a good predictor of 
performance. 

• Armed Services Vocational Aptitude Battery (ASVAB) Score Distribution (0 
- 135) - ASVAB Score is tied very closely to the aptitude and knowledge required 
to perform tasks that a particular specialty (or MOS) will require. 

• Reading Grade Level (<7 - >12) - Reading Grade Level is obviously related to 
training materials, job aids, and instructional manuals from which soldiers must 
be able to comprehend the information being presented. 

• Weight Lift - Weight Lift is tied very closely to the physical requirements to 
perform tasks that a particular specialty (or MOS) will require. 

• Psychological, Upper Extremities, Hearing, Lower Extremities, Eyes, 
Stamina (PUHLES) Eyes (1, 2, & >2) - The eyes rating from the PUHLES score 
is tied very closely to the visual requirements of the tasks that a particular 
specialty (or MOS) will perform. 
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Mental Model 
Personnel characteristics are important because they can be good predictors of how well 
soldiers will be able to perform mission critical tasks.  It is well known that soldiers with 
higher mental aptitude scores perform most tasks, especially cognitive type tasks, more 
accurately and in less time than soldiers with lower mental aptitude scores.  As the Army 
acquires more technologically sophisticated systems that require cognitive skills, rather 
than physical skills, it is important to determine if current MOSs will have the types of 
people needed to support those systems.  
 
It is not only a good idea to see what types of people are in an MOS today, but also to see 
who is likely to be in that MOS when a new system is scheduled to be fielded.  The 
personnel projection model in IMPRINT uses historical trend data to estimate the types 
of people likely to be in that MOS in future years.  Obviously, the further into the future 
the projection, the less likely the estimate will be correct.   
 
This analysis  can answer the following types of questions: 

• What percentage of the soldiers in this MOS are Test Score Category IV? 
• What is the expected reading grade level of the crew? 
• Will this MOS likely have more females in it eight years from now? 
• Are there major differences in the types of people in these MOSs? 
• What percentage of this MOS are high school graduates? 

Special Guidance 
A personnel flow model is used to make projections of what the selected Military 
Occupational Specialties (MOSs) are likely to look like in the future.  The projections are 
based on historical trend data contained in the IMPRINT library.  There is also an option 
within this module that allows you to change the historical trend data to reflect more 
recent personnel policies.  You should be very careful when changing historical trend 
data (i.e., separation rates, promotion rates, etc.) since there are many interdependencies 
within the flow model that could produce unrealistic results if the changes made are not 
logical.  The personnel flow model employs a modified Markov Chain algorithm to apply 
accession, continuation, promotion, and migration probabilities to determine projected 
inventories.  
 
Please note that the personnel data in IMPRINT are indicated by a certain date (e.g., the 
end of FY97 or 31 September 1997).  IMPRINT is updated periodically with personnel 
data from PERSCOM databases.  The personnel transition rate data for IMPRINT 
Version 4.0 are from FY97 records.  The personnel inventory data are as of 31 September 
1997.  The accuracy with which IMPRINT will describe MOSs is obviously dependent 
on when the data were last updated.  Also, there are constant changes in the Enlisted 
Personnel Classification System whereby MOSs are deleted, created, and consolidated.  
IMPRINT personnel data may or may not reflect these changes, depending on when the 
data where last updated.  The personnel projection model will only plan 20 years into the 
future.  
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The MOSs you select in this option will be available to the rest of the analysis under 
Define Mission, Define Equipment, and Define Force Structure menu options. 

Data Requirements 
All the data needed in this option are contained in IMPRINT libraries and provided 
automatically to users.  The model operates at the MOS, grade, year of service, and 
quality/demographic level of detail.  It begins with the current inventory from the Army’s 
Enlisted Master File (EMF).  It also uses the EMF to calculate historical transition rates 
(e.g., separations, promotions, migrations, etc.) for each subpopulation in an MOS.  
Subpopulations are defined by gender, high school graduate status, and test score 
category.  The model also uses historical accession data from the EMF, Army end 
strength projections from the Army Program Objective Memorandum (POM), and 
estimated available accessions from an Army Research Institute (ARI) propensity to 
enlist study. 
 
The only required user data are the MOSs to be projected and the ending year of the 
projection.  You can select both of these from lists.  You have the option of adding or 
deleting MOSs from the MOS list.  Also, as mentioned before, you can edit the flow 
model parameters (i.e., transition rates, available accessions, etc.).  

Analysis Steps 
1. To begin developing estimates of future personnel characteristics, choose the 

Soldiers option from the Define menu.  
 
2. Then, from the Define Soldiers dialog, adjust (by adding or deleting) the MOS list to 

include all MOSs for the analysis.  After that click on the Projection button. 
 
3. From the Projection dialog, select the MOSs to be projected and the ending year of 

the projection.  As an option, edit model parameters by selecting the appropriate 
parameter button. 

 
4. Click on the Run Model button to run the flow model.  
 
5. After the flow model runs, go to Reports on the main menu to see the results.  The 

reports interface allows you to tailor the reports to selected subpopulations within the 
MOSs.  
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Chapter 7 - Army Wide Manpower Requirements 

Goals and Results 
You can use the Define Force Structure capability in IMPRINT to develop Army-wide 
estimates for manpower required to operate, maintain, and support a weapon system.  
The objective of the force analysis is to project Army-wide manpower and personnel 
requirements for a new weapon system.  This is accomplished by estimating manpower 
and personnel requirements for a “pacing unit” and then extrapolating those results to 
estimate requirements for other units in the Army.  The major output of the force analysis 
are data that can be used to construct a Manpower Estimate (ME) report.  The ME report 
is a Congressionally mandated report that is due at Milestone II in the acquisition cycle.   
 
Although Define Force Structure can be used in a “stand alone” mode (i.e., without 
running through Define Mission, Define Equipment, or Define Soldiers first), the most 
common case will be to use it last after conducting the other analyses.  

Mental Model 
The Army is generally constrained by Congress to a fixed endstrength.  If a new system 
being introduced into the Army will require more manpower than its predecessor system, 
then the Army will be required to remove manpower from another system or function to 
support the new system.  If, on the other hand, a new system being introduced into the 
Army will require less manpower than its predecessor system, then the Army can allocate 
the additional manpower to other systems or functions.  
 
Because of this, there is a keen interest in the overall manpower impact of a new system.  
The overall manpower includes operators, maintainers, trainers, and all other support 
people required by the new system.  IMPRINT is able to help determine the overall 
manpower requirements by estimating the total number of operators and maintainers 
required for a new system during its fielding and steady state.  Not only may the number 
of people required for a new system be different than its predecessor, but the types of 
people needed may be different as well.  For example, the predecessor system may have 
had an extensive hydraulic system requiring maintainers with hydraulic repair skills. The 
new system, on the other hand, may have no hydraulics and instead have a “drive by 
wire” system that requires electrical and computer repairmen. 
 
The Define Force Structure analysis can answer the following types of questions: 

• What units will have predecessor systems replaced by new systems? 
• How many new systems will be fielded? 
• How many people in this maintenance MOS will be required in 2006? 
• What are the total operator and maintainer manpower requirements when the system 

is fully fielded?  
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Special Guidance 
Prior to performing this type of analysis, you should go to the Define Soldiers capability 
and add MOS’s to your analysis.  This process is described in Chapter 6, “Soldier 
Characteristics” of this Analysis Guide. 
 
Normally, you will have run a maintenance simulation in Define Equipment using a 
representative  unit (or “pacing” unit) in which the new system will be fielded.  Pacing 
units can be thought of as major building blocks within Divisions and Corps.  In many 
cases pacing units will be battalions.  For example, when modeling weapon systems in 
Infantry and Armor units, it is recommended that a battalion be modeled.  In another 
case, if modeling a new system for a chemical unit, it is recommended that a company be 
modeled.  The idea is to determine manpower requirements for the pacing unit, via 
modeling, and then multiply those manpower requirements by the number of those units 
in the Army, to get Army-wide manpower requirements. 

Data Requirements 
In Define Mission, you specify the crew members (and therefore crew size) for each weapon 
system.  Define Force uses the specified crew size as a basis for estimating Army-wide 
requirement for operators of the new system.  The number of required operators is a function of 
the types and numbers of units receiving the new system, the number of new systems being 
fielded, and the crew ratio.  Default values are provided for the crew when Define Mission was 
not exercised.  
 
The maintenance manpower requirements in Define Equipment for the simulated unit (i.e., 
pacing unit) will be used in Define Force Structure to compute manpower requirements for 
units in which the new system will be fielded.  The data from Define Equipment will provide 
the basis for estimating Army-wide manpower requirements for all other types and sizes of 
units.  Default values are provided for those units not modeled in Define Equipment. 
 
This does not mean that you cannot change the Define Equipment numbers once they are 
brought into Define Force.  You will have the option to edit them in Define Force.  You can 
change the Define Equipment data by choosing to edit MMHs.  The number of required 
maintainers is a function of the number and type of units, number of systems to be fielded, 
system reliability, maintenance ratio, operating tempo, and battle damage.  

Analysis Steps 
1. Select Force Structure from the Define option on the IMPRINT main menu. 
 
2. Initially, you identify the types and quantities of units in the Army Force Structure for 

which manpower requirements will be computed.  These will be the units in which 
the new system is scheduled to be fielded.  The Define Force Structure dialog is used 
to develop the list of all units that will be getting the new weapon system.  Use the 
Add button to add one or more parent units to the list.  After clicking on this button, 
you can select from a list of parent units or type in a parent unit.  Use the Delete 
button to remove highlighted parent units from the dialog list. 
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3. If you do not know what units to include in the Force Structure, you have the option 

of including all units.  Define Force will automatically provide a list of all units that 
have the type of weapon system for which the analysis is being conducted.  You can 
then edit this list.  The result is a list of active Army TOE units, by type and number, 
with the number of systems to be fielded, by year, for each type of unit. 

 
4. You can use the Unit Parameters dialog to specify the several data elements for each 

unit.  First, Annual Op Tempo is the number of hours per day that the new system is 
expected to operate in the type and size unit listed.  Measure is the unit used to 
measure op tempo ( e.g., flight hours, miles driven, etc.).  Annual MMHs/system are 
the total number of annual maintenance man-hours (by maintenance level) required to 
maintain one new system in that unit.  Finally, Crew Ratio is the average number of 
crews available for each new system in the unit.  In some cases where systems are 
required to operate continuously there may be multiple crews for each system. 

 
5. To review Army-wide manpower requirements go to Reports on the IMPRINT main 

menu and then select Force Structure. 
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Chapter 8 - Changing Personnel Characteristics 

Goals and Results 
Under the Options menu in IMPRINT, there is a menu item for PTS.  This lets you access 
the Personnel Characteristics, Training Frequency and Stressor data for your analysis.  
We recommend that you make adjustments in these areas in the same order of the tabs 
(i.e., P, then T, then S).  This is because the Personnel Characteristics describe the 
attributes that will arrive with the soldiers manning your system.  Then, you can train 
those soldiers to perform the tasks.  Finally, when the soldiers perform the tasks, they 
will be subjected to environmental stressors.   
 
The Personnel Characteristics option allows you to change the Armed Services 
Vocational Aptitude Battery (ASVAB) composite and cutoff score for the Military 
Occupational Specialty (MOS) performing the tasks.  The current ASVAB composite and 
cutoff score (used to select people for the MOS) are defaults.  You can change these 
values to investigate changes in performance.  Higher cutoff scores will normally result 
in better performance (i.e., more accurate and less time) but will cause less people to be 
available for the MOS. 

Mental Model 
Personnel characteristics are important because they can be good predictors of how well 
soldiers will be able to perform mission critical tasks.  It is well known that soldiers with 
higher mental aptitude scores perform most tasks, especially cognitive type tasks, more 
accurately and in less time than soldiers with lower mental aptitude scores.  As such, one 
option in obtaining better system performance is to assign a crew with higher mental 
aptitude scores to the system.  This equates to raising the ASVAB cutoff score.  The cost 
of doing this reduces the number of people that will be available to serve as a crew 
member.   
 
If a new system will require the operators to perform tasks that weren’t required in the 
predecessor system, the possibility of creating a new MOS to operate the system could be 
an alternative that should be investigated.  
 
You can use the Personnel Characteristics option to answer the following types of 
questions: 

• If I raise the operator MOS cutoff score to 105, will I achieve my mission 
performance standard? 

• How many in the current MOS will be available if the cutoff score is raised to 
105? 

• How much better do Test Score Category I soldiers perform these tasks than 
do Test Score Category IV soldiers? 

• What is the trade-off between increased performance and personnel 
availability? 
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• What is the difference between current cutoff scores for these two MOSs? 

Special Guidance 
Prior to performing this type of analysis, you should go to the Define Soldiers capability 
and add MOS’s to your analysis.  This process is described in Chapter 6 of this Analysis 
Guide.  If you have not selected MOS’s or if you have only officers, or if you have not 
entered Taxons on the Task Information dialog, then you will not be able to use this 
option. 
 
Changing personnel characteristics is one of three options (the other two are changing 
sustainment training frequency and applying stressors) that you can select to influence 
task and therefore mission performance.  Because of the way in which these options are 
calculated, they should be exercised in a particular order.  Changing personnel 
characteristics should be done first, then changing sustainment training frequency, and 
applying stressors last.  
 
The reason for this is avoid the potential for getting negative numbers for performance 
accuracy.  Since stressors have greater impacts on performance than do the other two 
options, it is quite likely that applying a severe stressor (e.g., 76 hours without sleep) will 
cause task accuracy to be near zero.  If this severe stressor were applied first, rather than 
last, it is possible that the other optional adjustments will get a negative accuracy value.  
Once again, this is because of the way the adjustments are calculated.  For example, the 
stressor adjustment is made by multiplying the mean accuracy by a computer degradation 
factor.  The sustainment training adjustment, on the other hand, is made by subtracting a 
computer value from the mean accuracy.     
 
The prediction equations for changes in performance based on changes in personnel 
characteristics are based on data from Project  A. Project A is an Army Research Institute 
effort that involves measuring soldiers’ performance on many different types of tasks.  
The original prediction equations were based on Project A data from the mid-1980’s.  
The prediction equations have since been updated based more resent (mid-1990’s) 
Project A data. 
 
When choosing an ASVAB composite cutoff score, you should realize that a higher 
cutoff score will generally result in better performance within the MOS; however, there 
will be fewer people available that can attain the higher cutoff score.  The number of 
people available in an MOS at each cutoff score can be seen in the “Availability vs 
ASVAB Cutoff” report in the personnel characteristics report section.   
 
There are two options for setting minimum (i.e., cutoff) scores for personnel 
characteristics.  Both options involve measures obtained from the Armed Services 
Vocational Aptitude Battery (ASVAB).  The ASVAB is a battery of tests administered to 
enlistees prior to entering the military services.  It is important to note that changes in the 
Test Score Category Cutoff will cause IMPRINT to automatically update the ASVAB 
Composite Cutoff to reflect the new Test Score Category that you have selected.  
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IMPRINT will also automatically update the Test Score Category Cutoff to reflect 
changes you make to the ASVAB Composite Cutoff.  The two options are as follows: 
 

1. Change Test Score Category Cutoff - This option allows you to set a minimum 
"mental category" for a Military Occupational Specialty (MOS) and then see how 
performance would be affected.  Mental category (now called "Test Score Category") 
refers to the score obtained on the Armed Forces Qualification Test (AFQT), which is 
derived from the ASVAB.  The different Test Score Categories are: 

 
Test Score Category AFQT Score 

I 93-99 
II 65-92 
IIIA 50-64 
IIIB 31-49 
IV 10-30 

 
When you pick a Test Score Category cutoff, the MOS will include the chosen Test 
Score Category and all others above it (e.g., Choosing "IIIA" will result in the MOS 
having mental categories I, II, and IIIA).  IMPRINT will automatically estimate the 
ASVAB cutoff that is associated with the Test Score Category cutoff you select.  

 
2. Change ASVAB Composite Cutoff - This option allows you to set a minimum 

ASVAB Composite score for the MOS and then see how performance would be 
affected.  The ASVAB itself consists of 10 sub-tests from which "composites" are 
constructed by combining two or more of the sub-tests.  Each MOS uses one or two 
of the composites to control who can enter the MOS.  Setting composite cutoff 
scores, which must be attained in order to enter the MOS, does this.  Each MOS is 
assigned a composite that is best for measuring the skills and aptitudes required to 
perform jobs well in the MOS. 

 
It is important to note that any personnel characteristic changes that you make may alter 
the stored accuracy, time, and/or probability values that IMPRINT has for that particular 
task or MOS, within your analysis.  If you make personnel characteristic changes, 
IMPRINT will produce a "Delta" Report that will show you how task performance has 
been changed.  When this "Delta" Report is produced, you should print this report (either 
to a file or to your printer) in order to maintain a record of your changes. This record is 
important because you can make further changes in other places in IMPRINT.  As these 
changes add up, it can be difficult, if not impossible, to regain your initial values.  You 
should print any subsequent "Delta" Reports as well. 
 
If you have not selected any MOSs, or you have only officers, or you have not put 
assigned taxons to tasks, you will not be able to access or use this option. 
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Data Requirements 
You select the ASVAB Composite and Cut-off Score or the Test Score Category to apply 
to selected tasks.  You select these from drop down lists.  

Analysis Steps 
1. From the Options menu item, chose PTS.  This will open a dialog that shows 

Personnel Characteristics, Training Frequencies, and Stressors on tabs at the bottom 
of the dialog.  Select the Personnel Characteristics tab.  This option allows you to 
change the Armed Services Vocational Aptitude Battery (ASVAB) composite and 
cutoff score for the Military Occupational Specialty (MOS) performing the tasks.  

 
2. You can apply this change to selected tasks or to all tasks assigned to a particular 

crewmember or position.   
 
3. The current ASVAB composite and cutoff score (used to select people for the MOS) 

are shown initially in the dialog box.  You can edit these values.  First you can select 
the ASVAB composite to be used from a drop down menu that will appear when you 
click on the drop down control.  The same method is used to edit the field labeled 
"Cutoff."  

 
4. Once you have selected a particular Test Score Category, you can see a report 

summarizing the impact that your choice has had on task Accuracy, Time, and the 
Probability of achieving the minimum acceptable accuracy by clicking on the Review 
button. 



IMPRINT Version 7 

 
Analysis Guide 

53

 

Chapter 9- Changing Sustainment Training Frequency 

Goals and Results 
Under the Options menu in IMPRINT, there is a menu item for PTS.  This lets you 
access the Personnel Characteristics, Training Frequency and Stressor data for your 
analysis.  The Training Frequency option allows you to review and edit training 
frequencies for each task.  One of five training levels can be assigned to a task.  You 
should choose the training level which best describes how often operators or maintainers 
perform the task.  Performance of the task could be part of a training exercise or actual 
job performance.  In general, the more frequently an individual practices or performs a 
task, the more accurately they will perform it.  Also, an increase in training frequency 
will normally decrease the time required to perform the task. 

Mental Model 
One way to improve system performance is to train more frequently on critical tasks or 
missions that must be performed.  The cost of doing this is obviously in terms of training 
resources (fuel, ammo, time, etc.) required.  The type of training addressed here is 
sustainment training in operational units and not the type of training received in the 
schools or initial entry training.  
 
This capability in IMPRINT can be used to answer the following types of questions: 

• If I raise the training frequency to once a week will I achieve my mission 
performance standard? 

• What is the trade-off between increased performance and increased training 
frequency?  

Special Guidance 
Prior to performing this type of analysis, you should go to the Define Soldiers capability 
and add MOS’s to your analysis.  This process is described in Chapter 6, “Soldier 
Characteristics” of this Analysis Guide. 
 
If you are trying to improve task performance to meet accuracy or time standards, 
increasing training frequency is one possible alternative.  An increase in training 
frequency, however, will often require additional resources (e.g., an increase in the 
frequency with which soldiers zero the sights of their weapons will require more 
ammunition).  If you do not assign sustainment training frequencies to tasks, the average 
(i.e., once a month) will be assigned automatically.  
 
You should choose the training level which best describes how often operators or 
maintainers will perform the task.  Performance of the task could be part of a training 
exercise or actual job performance.  In general, the more frequently an individual 
practices or performs a task, the more accurately they will perform it.  Also, an increase 
in training frequency normally will decrease the time required to perform the task. 
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It is important to note that any training frequency changes that you make may alter the 
stored accuracy, time, and/or probability values that IMPRINT has for that particular task 
or MOS, within your analysis.  If you make training frequency changes, IMPRINT will 
produce a “Delta” Report that will show you how task performance has been changed.  
When this “Delta” Report is produced, you should print this report (either to a file or to 
your printer) in order to maintain a record of your changes.  This record is important 
because you can make further changes in other places in IMPRINT.  As these changes 
add up, it can be difficult, if not impossible, to regain your initial values.  You should 
print any subsequent “Delta” Reports as well. 

Data Requirements 
To perform this analysis you select from one of five training frequencies for selected 
tasks.  

Analysis Steps 
1. From the Options menu item, chose PTS.  This will open a dialog that shows 

Personnel Characteristics, Training Frequencies, and Stressors on tabs at the bottom 
of the dialog.  Select the Training Frequency tab.  This option allows you review 
and edit training frequencies for each task. One of five training levels can be assigned 
to a task. 

2. You can apply this change to selected tasks or to all tasks assigned to a particular 
crewmember or position.   

3. Select the tasks to which you want to apply the training frequency adjustment. 
4. Select from one of five training frequencies, from a drop down list, for selected tasks. 

Then click on the Apply button.   
5. In order to see the effects of changing training frequencies you should click on the 

Review button.  Once you have finished applying a training frequency, it is recorded 
for that particular Task or Military Occupational Specialty (MOS) and can be referred 
to or edited later.  
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Chapter 10 - Applying Stressors 

Goals and Results 
Under the Options menu in IMPRINT, there is a menu item for PTS.  This lets you 
access the Personnel Characteristics, Training Frequency and Stressor data for your 
analysis.  There are five different stressors that can be applied to tasks. They are:  
Mission Oriented Protective Posture (MOPP) gear for individual nuclear, biological, and 
chemical defense; heat; cold; noise; and sustained operations (i.e., lack of sleep).  
Stressors may be reviewed and changed for each individual task, one at a time, or, for an 
entire group of tasks, all at once.  Depending upon the specifics of the task and MOS, 
adding stressors may decrease task accuracy and/or increase the time it takes to complete 
the task.    

Mental Model 
Performance on a task or mission under ideal conditions may differ drastically from 
performance on the same task or mission under stressful conditions.  The environment in 
which military operations (tasks and missions) are conducted can be very stressful.  
IMPRINT provides performance prediction equations for 5 different environmental 
stressors (listed above) that can impact performance.  This allows you to estimate mission 
performance under “worst case” conditions.  
 
An analysis of this type will enable you to answer the following questions: 

• Can the crew still emplace the Howitzer in 2 minutes or less when they are 
required to be in MOPP IV? 

• Which will degrade performance on this task the most--extreme heat or 
extreme cold? 

• What is the combined effect of lack of sleep and extreme heat on mission 
performance? 

• Which stressor will degrade time and accuracy the most on these tasks? 
• Which of these tasks will be degraded (in terms of performance) the most by 

this stressor? 

Special Guidance 
It is important to note that any stressors that you apply may alter the stored accuracy, 
time, and/or probability values that IMPRINT has for that particular task or MOS, within 
your analysis.  If you apply stressors, IMPRINT will produce a "Delta" Report that will 
show you how task performance has been changed.  When this "Delta" Report is 
produced, you should print this report (either to a file or to your printer) in order to 
maintain a record of your changes.  This record is important because you can make 
further changes in other places in IMPRINT.  As these changes add up, it can be difficult, 
if not impossible, to regain your initial values.  You should print any subsequent "Delta" 
Reports as well. 
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In order to see the effects of stressors you should apply them one at a time (i.e., apply a 
stressor and run the model to see the impacts; then apply another stressor and rerun the 
model to see additional impacts).  Although it is possible in IMPRINT to apply multiple 
stressors at the same time, the overall performance effects cannot be broken out and 
attributed to individual stressors.  
 
In order for stressors to affect task performance, each task must be assigned to Taxons.  
The table below indicates the impact of stressors by taxon. 
 

TAXON MOPP Heat Cold Noise Sleepless 
Hours 

Visual T A T   
Numerical  A   TA 
Cognitive  A   TA 
Fine Motor Discrete T A T   
Fine Motor Continuous      
Gross Motor Light T  T   
Gross Motor Heavy      
Commo (Read & Write)  A    
Commo (Oral) T A  A  

 
T = Affects task time.    A = Affects task accuracy    TA = Affects both 
 

For more detailed information on how the stressors are used to affect task time and 
accuracy, please refer to the Appendix in the IMPRINT User’s Guide.  It contains a 
technical paper, “Evaluation of Human Performance under Diverse Conditions via Modeling 
Technology” (Allender, Salvi, Promisel) that describes these relationships. 

Data Requirements 
You can select the stressor and the levels (e.g., for the heat stressor, the levels are 
temperature and relative humidity) to apply from drop down lists.  Although it is possible 
in IMPRINT to apply multiple stressors at the same time, it is recommended that they be 
applied one at a time to see the effects of each.  In order to apply stressors, you must have 
assigned Taxons to the tasks.  You can do this by accessing the Task Information dialog 
(through the Define Mission option), and using the Taxons tab.  For more information, 
see Chapter 3, “Using IMPRINT” in the IMPRINT User’s Manual. 

Analysis Steps 
1. From the Options menu item, chose PTS.  This will open a dialog that shows 

Personnel Characteristics, Training Frequencies, and Stressors on tabs at the bottom 
of the dialog.  Select the Stressors tab.  This option allows you review and edit 
stressors for each task.  

 
2. You can apply this change to selected tasks or to all tasks assigned to a particular 

crewmember or position.   



IMPRINT Version 7 

 
Analysis Guide 

57

 
3. Select the tasks to which you want to apply the stressor adjustment. 
 
4. Select a stressor and the stressor levels from drop down lists, for selected tasks. Then 

click on the Apply button.   
 
5. In order to see the effects of applying stressors you should click on the Review button 

on the Apply Stressors dialog box.  Once you have finished applying a stressor, it is 
recorded for that particular Task or Military Occupational Specialty (MOS). 


